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           Tindakan Pengamanan  
 

(Harap baca dengan seksama sebelum training ) 
 
Ketika mendesain sistem, pastikan selalu membaca manual dan bersamaan dengan 
itu mohon agar memberi perhatian penuh terhadap keamanan.  
Kemudian, pada saat  training harap memperhatikan hal - hal dibawah ini dan 
mohon untuk menggunakannya dengan tepat. 
 
 
 

【 Item perhatian dalam  training】 
 
 

PERINGATAN  
 Agar tidak tersengat listrik, jangan menyentuh terminal pada saat listrik mengalir.  
 Saat membuka cover pengaman, kerjakanlah setelah mematikan power atau 

setelah memastikan kembali keamanannya.   
 Jangan memasukkan tangan anda ke bagian yang bergerak.  

 

PERHATIAN   
 Lakukanlah training sesuai dengan instruksi instruktur.   
 Koneksikan ground terminal power plug dengan colokan 3pin.    

Jika menggunakan conversion adaptor 3pin-2pin, koneksikan groundwire conversion 
adaptor pada ground terminal dari colokan.   

 Jangan melepas unit training kit tanpa ijin dan jangan mengubah wiring. Hal ini dapat 
menyebabkan kerusakan, malfungsi dan kebakaran.   

 Silahkan memasang atau melepaskan unit setelah meng- OFF- kan powernya. Jika 
dijalankan pada saat listrik mengalirkan menjadi penyebab terjadinya malfungsi pada 
unit dan sengatan listrik.   

 Ketika pada training kit (tabel X/Y dll) timbul bau menyengat atau suara yang aneh, 
segera matikan  power switch.   

 Jika timbul hal yang tidak normal segera hubungi instruktur.  

PERHATIAN: 
Training kit catu daya menggunakan power supply 100 volt.
JANGAN MENGGUNAKAN power supply selain spesi�kasi tersebut.
Dapat mengakibatkan kerusakan atau kebakaran.
Mohon menggunakan transformer sesuai kebutuhan.
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Mari belajar sequence

Mari mengenal sequence control
Sequence yang akan diperkenalkan adalah alat untuk menjalankan “sequence 

control”. Jadi, apakah “ sequence control” itu?

Kosakata yang biasanya jarang didengar tetapi sesungguhnya ada banyak 

disekitar kita, siapapun pernah bersinggungan walaupun hanya sekali saja.

Misal, mesin cuci otomatis, ini pun “sequence control“ yang luar biasa.

Pada bab ini, kita akan membahas tentang sequence control dan contoh aktual 

yang ada disekitar kehidupan kita.

Apa itu “Sequence Control?"
BAB 1
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1.1 Apa itu “Sequence Control?"
1.1.1 Apa Arti Sequence Control?
“Sequence control” …. Kosakata yang tidak bagitu dikenal secara umum, akan 
tetapi sangat sering digunakan disekitar kita, walau hanya sekali kita pasti 
pernah berhubungan dengan alat ataupun mesin yang dikontrol oleh sequence 
control.
Pertama-tama, jika mencari arti sequence di kamus,

Dari hal tersebut dapat disimpulkan bahwa sequence adalah hal yang 
berlangsung terus menerus, atau urutan terjadinya fenomena. “Sequence 
control” yang juga datang dari kata “sequence”, dikatakan bahwa dioperasikan 
sesuai urutan yang telah ditentukan. Dan dikatakan juga mengontrol agar 
beroperasi sesuai dengan yang diinginkan.

1.1.2 Jika Dicontohkan Dengan Barang-barang 
Disekitar Kita
Contohnya, mesin pencuci mobil yang sering kita lihat di pom bensin.

(1) Hal yang berlangsung terus menerus, berturut-turut,
dan berkelanjutan 

(2) Hal yang berturut-turut, hal yang bersambung 

(3) Urutan, urutan, order 

(4) Kejadian yang terjadi setelahnya, after effect, hasil,dll. 
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Pengoperasian  mesin  pencuci  mobil  di  halaman  sebelumnya  memang  
merupakan prosedur kasar, tapi justru  urutan operasional inilah cara  kerja  
sequence, dioperasikan secara  otomatis, walaupun  dilakukan berapa kalipun  
selalu  tepat  dan  sesuai  dengan keinginan sequence inilah yang disebut 
dengan sequence control. Selain itu, sequence control digunakan pada tiap 
bidang dan berbagai arah secara luas, sehingga cara kerja ini menjadi hal yang 
harus ada. 

Sequence control tidak hanya digunakan dalam aplikasi yang kompleks tapi juga 
dalam berbagai aplikasi yang umum.

FA (factory automation) Peralatan di pabrik

Kontrol pada conveyor, berbagai mesin pengolahan, 
mesin perakitan, dll.

•  Mesin cuci ukuran besar.
•  Mesin penjual tiket.
•  Peralatan individu yang spesifik, seperti kulkas-freezer.

•  Kontrol pada tempat parkir.
•  Kontrol pada conveyor logistik.
•  Kontrol pada pintu air.
•  Kontrol pada lampu lalu lintas dan pencahayaan.
•  Kontrol pada penutup pintu, dll.

 Produksi pangan dan peralatan 
  pengolahan

 Berbagai kontrol otomatisasiBerbagai peralatan untuk bisnis

0 0 0 0 0

0 0 0 0 0

0 0 0 0 0

0 0 0 0 0

0000Ticket

Kontrol pada tiap-tiap mesin produksi, bahan baku,  
percetakan, pemanasan, pemotongan, dan pengemasan.

DIGUNAKAN DI BERBAGAI BIDANG
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START

STOP

1.2 Seputar Sequence Control
1.2.1 Yang Menstruktur Sequence Control
Untuk menjalankan sequence control, digunakanlah peralatan seperti berikut.

Peralatan ini dibagi menjadi “alat yang dioperasikan oleh manusia”, “alat yang 
memberitahukan kondisi mesin pada manusia”, “ alat yang mendeteksi kondisi 
mesin”, dan “ alat yang menggerakkan mesin”.

Misalnya mesin pencuci mobil yang menggunakan 
kombinasi berbagai peralatan dalam sequence control.

Alat yang dioperasikan oleh manusia Alat yang memberitahukan kondisi mesin pada manusia

Alat yang menggerakkan mesin

Manusia

Saklar, dll. Lampu, buzzers, dll.

Pompa untuk mengeluarkan air
dan deterjen, serta motor untuk
memutar sikat

Sequence

Alat yang dioperasikan manusia Alat yang mendeteksi kondisi mesin

Tombol start/stop.

Alat yang memberikahukan kondisi mesin pada manusia

Lampu pada saat mesin beroperasi.

Saklar, dll. Untuk mendeteksi kedatangan mobil.
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START

STOP

1.2 Seputar Sequence Control
1.2.1 Yang Menstruktur Sequence Control
Untuk menjalankan sequence control, digunakanlah peralatan seperti berikut.

Peralatan ini dibagi menjadi “alat yang dioperasikan oleh manusia”, “alat yang 
memberitahukan kondisi mesin pada manusia”, “ alat yang mendeteksi kondisi 
mesin”, dan “ alat yang menggerakkan mesin”.

Misalnya mesin pencuci mobil yang menggunakan 
kombinasi berbagai peralatan dalam sequence control.

Alat yang dioperasikan oleh manusia Alat yang memberitahukan kondisi mesin pada manusia

Alat yang menggerakkan mesin

Manusia

Saklar, dll. Lampu, buzzers, dll.

Pompa untuk mengeluarkan air
dan deterjen, serta motor untuk
memutar sikat

Sequence

Alat yang dioperasikan manusia Alat yang mendeteksi kondisi mesin

Tombol start/stop.

Alat yang memberikahukan kondisi mesin pada manusia

Lampu pada saat mesin beroperasi.

Saklar, dll. Untuk mendeteksi kedatangan mobil.

Diagram tersebut diatas hanyalah salah satu contoh dan masih banyak lagi 
peralatan yang lainnya.

Sequence control beroperasi sesuai dengan urutan kerja yang mengkombinasi 
alat seperti ini. Kemudian, pada “alat yang dioperasikan manusia“, “alat yang 
mendeteksi kondisi mesin”, menjadi kondisi pada sequence control Sedangkan 
“alat yang memberitahu kondisi mesin pada manusia”,  “alat yang menggerakkan 
mesin”menjadi alat yang beroperasi berdasarkan kondisi tersebut.

Panel Operasi ------- Panel yang diinstal alat yang dioperasikan manusia 
(pushbutton switch, selector switch, dll) atau alat 
yang memberitahukan kondisi mesin pada manusia 
(lampu, indikator digital, dll)

Panel Kontrol -------- Panel  yang  menyediakan  alat  untuk  mengontrol  
pergerakan  mesin  seperti  kontaktor 
elektromagnetik, relay, PLCs, dll

Kontraktor magnetik, relay, dll.

Alat yang mendeteksi keadaan mesin Alat yang menggerakkan mesin
Mesin

Limit switches, proximity switches, dll. Motor, solenoid valves, dll.

Untuk alat yang bermuatan kecil seperti solenoid value 
ukuran kecil, lampu pilot dapat bergerak langsung dari 
PLC tetapi alat bermuatan besar seperti solenoid value 
berukuran besar perlu bergerak melalui kontraktor 
elektromagnetik (magnet contractor) dan relay.

Control
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1.3 Yang Dibutuhkan Oleh Sequence 
Control
1.3.1 Mari Pikirkan Tentang Sequence Control Secara Konkret

Mari coba pikirkan tentang sequence control secara konkret berdasarkan 
diagram koneksi berikut ini. Kemudian disini akan dijelaskan pula istilah yang 
perlu diketahui dalam mempelajari sequence control.

 Contoh 1  rangkaian listrik berikut ini di-wiring menggunakan pushbutton, lampu 
(biru, merah) dan relay.
---- Isi sequence control
(1) Pada kondisi pushbutton tidak ditekan listrik mengalir pada rute line B, maka           
     lampu biru akan menyala.
(2) Jika pushbutton ditekan listrik mengalir pada rute line A, maka lampu merah    
     akan menyala.
(3) Jika pushbutton dilepaskan, lampu biru akan menyala lagi seperti (1),     
     Operasi (1)-(3) menjadi salah satu bagian dari sequence control.

Diagram Koneksi

Lampu Biru

Lampu Merah

Relay

Pushbutton

Power supply

Power supply

A

B
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    Tentang contact dan tipenya 
Contact memiliki peranan untuk mengkonduksikan atau mematikan listrik sesuai 
dengan jalannya operasi pembukaan dan penutupan. Pada dasarnya contact terdiri 
dari 2 yaitu, “N.O. (Normally Open) contact” dan “N.C. (Normally Close) contact”. 
Contact dimiliki oleh oleh switch, relay, timer, counter, dll.

Catatan 1  yang disebut instruksi memiliki arti dioperasikan, dirubah, jika tombol ditekan maka
      penekanan tombol itulah yang disebut instruksi.

N.O. contacts

N.C. contacts

Operasi:    Jika dianalogikan switch pushbutton
                   Jika tidak menekan switch push button, contactakan terbuka. Jika
                   menekan tombol, contact akan tertutup.

Operasi:    Jika dianalogikan switch pushbutton
                   Jika tidak menekan switch push button, contact tertutup. Jika
                   menekan tombol, contact akan terbuka.

1.3.2 Mari Belajar Istilah Baru

Tombol Tekan

Tombol Tekan

Kontak bergerak

Kontak bergerakKontak bergerak

Kontak bergerak

Tombol ditekan

Tombol ditekan

Kontak diam

Kontak diam

Kontak diam

Aliran arus listrik

Aliran arus listrik

Kontak diamKabel

Kabel KabelKabel

Rangkaian 
tertutup Sirkuit

terbuka

Kabel

Kontak

Kabel Per

Per Per

Sebelum tombol ditekan (posisi saat kembali) Setelah tombol ditekan (posisi saat beroperasi)
Per

Rangkaian
terbuka

N.O. contact, mengacu pada contact yang biasa terbuka, tapi contact akan 
menutup bila mendapat instruksi.

N.C. contact mengacu pada contact yang biasanya tertutup, tapi contact akan
membuka bila mendapat instruksi.
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Tentang relay 
Relay merupakan elektrik relay yang sesuai dengan namanya memiliki arti 
menyampaikan arus listrik. Sebetulnya didalam relay terdapat elektromagnet, dan 
karena kinerja elektromagnet ini menarik lempengan besi yang bergerak sehingga 
contact* dapat membuka atau menutup.

Contact 
Bergerak

Contact 
Bergerak

Aliran listrik sedang 
mengalir dalam contact.

Contact Berhenti Contact tetap

Aliran
Listrik

Per

Saat arus listrik mengalir 
ke dalam elektromagnet 
kontak akan bergerak.

Saat arus listrik berhenti, kontak 
yang bergerak akan berhenti 
kembali pada posisi sebelumnya.

 

Contact OFFContact ON

N.C. (normally close) contacts

Contact
tetap

Contact Bergerak Aliran listrik yang 
ada dalam contact

Contact 
Berhenti

Elektromagnet Elektromagnet

Elektromagnet
Elektromagnet

Aliran listrik
mengarah ke coil

Per

Saat arus listrik mengalir 
ke dalam elektromagnet 
kontak akan bergerak.

Saat arus listrik berhenti, kontak 
yang bergerak akan berhenti 
kembali pada posisi sebelumnya.

Contact OFF
Contact ON

N.O. (normally open) contacts

 *Contacts : Dikatakan sebagai bagian penyambung yang melakukan operasi penutupan dan pembukaan, serta 
mengkonduksikan atau mematikan aliran listrik. Selain relay, switch, timer, counter, dll juga memiliki contact. 
Kemudian didalam contact, terdapat N.O. (normally open) contact dan N.C. (normally close) contact. (referensi             
pada halaman sebelumnya).
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     Mengapa relay itu diperlukan
(1) Relay menggerakkan motor besar,lampu, dll hanya dengan sinyal kecil.

   

(2) Dapat mengontrol berbagai power seperti menggerakkan AC motor di DC 
     control seperti diagram berikut.

12 V DC(direct current)

100 V AC(Alternate current)
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Konfigurasi Produk

1.4 Latihan Memasang Kabel Berdasarkan 
Sequence control
1.4.1 Setelah Belajar Istilah Baru
Setelah belajar tentang relay contact, 
mari coba training dengan contoh 1 
di halaman 1-6.

Kabel power 1 kabel
Pushbutton 1 buah
Lampu merah 1 buah
Lampu biru 1 buah
Relay 1 buah
Kawat timah
(coklat, merah, oranye, kuning, hijau, biru, ungu, abu abu) masing- masing 1 kabel

Catatan) Pada contoh ini kabel power no 4 
dan 5 terhubung pada terminal yang sama.

*1  Apa itu "actual wiring diagram?"

   Mari menyusun kabel pada model demonstrasi latihan 
(1) Pastikan power listrik dalam keadaan mati 

(2) Diagram 1. wiring pada lampu merah dengan 
menghubungkan kabel : 
kabel warna hijau ke terminal nomer 5 
kabel warna biru ke terminal nomer 6 
kabel warna coklat ke terminal nomer 1 
kabel warna merah ke terminal nomer 2 
kabel warna oranye ke terminal nomer 3 
kabel warna ungu ke terminal nomer 7 

(3) Diagram 2. wiring pada lampu merah dengan 
menghubungkan kabel :
kabel warna kuning ke terminal nomer 4 
kabel warna abu abu ke terminal nomer 8 

Dikatakan sebagai diagram yang 
menunjukkan alat yang digunakan rangkaian 
dan koneksi rangkaian dan sebisa mungkin 
mendekati tipe aslinya. Supaya wiring dan 
struktur alat dapat dilihat dengan tepat, 
diagram ini memproduksi alat secara riil dan 
menjadi praktis pada saat maintenance.

Lampu Merah
Lampu Biru

Relay

Tombol tekan

DC power supply

Lampu Merah

Diagram kabel *1

Diagram 1. Lampu Biru

Merah Biru

AWAS
Lampu 1 Lampu 2

Contact
umum N.C. contact Relay

Coil

Pushbutton

tombol tekan
N.O.  contact

Lampu 1 Lampu 2

jangan menyambungkan dengan terminal 
power supply voltase eksternal 24 V DC 

Merah Biru

AWAS
Lampu 1 Lampu 2

Contact
umum N.C. contact Relay

Coil

Pushbutton

tombol tekan
N.O. contact

Lampu 1 Lampu 2

jangan menyambungkan dengan terminal 
power supply voltase eksternal 24 V DC 
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Konfigurasi Produk

1.4 Latihan Memasang Kabel Berdasarkan 
Sequence control
1.4.1 Setelah Belajar Istilah Baru
Setelah belajar tentang relay contact, 
mari coba training dengan contoh 1 
di halaman 1-6.

Kabel power 1 kabel
Pushbutton 1 buah
Lampu merah 1 buah
Lampu biru 1 buah
Relay 1 buah
Kawat timah
(coklat, merah, oranye, kuning, hijau, biru, ungu, abu abu) masing- masing 1 kabel

Catatan) Pada contoh ini kabel power no 4 
dan 5 terhubung pada terminal yang sama.

*1  Apa itu "actual wiring diagram?"

   Mari menyusun kabel pada model demonstrasi latihan 
(1) Pastikan power listrik dalam keadaan mati 

(2) Diagram 1. wiring pada lampu merah dengan 
menghubungkan kabel : 
kabel warna hijau ke terminal nomer 5 
kabel warna biru ke terminal nomer 6 
kabel warna coklat ke terminal nomer 1 
kabel warna merah ke terminal nomer 2 
kabel warna oranye ke terminal nomer 3 
kabel warna ungu ke terminal nomer 7 

(3) Diagram 2. wiring pada lampu merah dengan 
menghubungkan kabel :
kabel warna kuning ke terminal nomer 4 
kabel warna abu abu ke terminal nomer 8 

Dikatakan sebagai diagram yang 
menunjukkan alat yang digunakan rangkaian 
dan koneksi rangkaian dan sebisa mungkin 
mendekati tipe aslinya. Supaya wiring dan 
struktur alat dapat dilihat dengan tepat, 
diagram ini memproduksi alat secara riil dan 
menjadi praktis pada saat maintenance.

Lampu Merah
Lampu Biru

Relay

Tombol tekan

DC power supply

Lampu Merah

Diagram kabel *1

Diagram 1. Lampu Biru

Merah Biru

AWAS
Lampu 1 Lampu 2

Contact
umum N.C. contact Relay

Coil

Pushbutton

tombol tekan
N.O.  contact

Lampu 1 Lampu 2

jangan menyambungkan dengan terminal 
power supply voltase eksternal 24 V DC 

Merah Biru

AWAS
Lampu 1 Lampu 2

Contact
umum N.C. contact Relay

Coil

Pushbutton

tombol tekan
N.O. contact

Lampu 1 Lampu 2

jangan menyambungkan dengan terminal 
power supply voltase eksternal 24 V DC 

Mari Memastikan Kembali Operasi
Coba bandingkan penjelasan dari sequence control pada halaman 1-6 dengan 
pengetahuan yang baru saja dipelajari. 
① Bila power dinyalakan N.C. contact terhubung dan listrik akan mengalir di rute B 
    dan lampu biru akan menyala.
② Setelah itu, jika pushbutton switch (N.O. contact) ditekan, N.O. contact akan 
    menutup ,listrik akan mengalir di rute A dan  lampu  merah akan  menyala. 
③ Jika pushbutton-nya dilepas, lampu biru akan menyala kembali.

Apa itu "flow chart?"
Dengan sequence control, berbagai macam perangkat akan diintegrasikan 
menjadi sebuah rangkaian. Untuk menjelaskan cara kontrol dari berbagai 
perangkat ini akan sangat sulit menggunakan metode standar. Oleh karena itu 
flow chart merupakan metode yang lebih diutamakan untuk menjelaskan tentang 
control sekuens. Flow chart menggunakan simbol persegi empat dan panah 
untuk lebih memudahkan pemahaman operasional.

Apa itu "time chart?"
Time chart digunakan untuk memahami perubahan operasi sekuens 
berdasarkan waktu. Perangkat yang akan dikontrol dilambangkan dalam garis 
vertikal sedangkan perubahan berdasarkan waktu dilambangkan dengan garis 
horizontal. Garis putus putus dengan tanda panah menunjukkan hubungan 
antara perangkat dengan hasil operasi.Time chart kadang melambangkan 
perubahan berdasarkan waktu tanpa menggunakan panah.

Isi sequence control dapat diketahui baik dari  flow chart atau time chart.

Power ON Tombol
Sudah Ditekan?

Lampu Biru Lit
Lampu Merah  
Out

Sequence yang ditunjukkan sebagai flow chart

TIDAK

Tombol tekan

Relay

Ditekan

Beroperasi

Lit

Lit Lit

Tertutup

Dilepaskan

Lampu Biru

Lampu Merah

Tombol tekan

TIDAK

YA
YA

Relay

Sequence yang ditunjukkan sebagai time chart

Tombol
Tidak Ditekan?

Lampu Biru Lit
Lampu Merah  
Out
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Actual wiring diagram adalah metode diagram yang mudah dimengerti tentang 
struktur alat, wiring dll, akan tetapi pada rangkaian listrik yang rumit, urutan 
pengoperasiannya menjadi sulit untuk dipahami. Agar dapat mudah memahami hal 
tersebut maka diganti dengan diagram sequence.

Diagram sequence adalah  diagram  yang dimaksudkan untuk membuat 
pengoperasiannya mudah dimengerti sesuai dengan urutan pengoperasian dari 
banyak rangkaian. Kemudian, karena metode diagram ini menggunakan standar 
yang sama maka pihak ketiga yang melihatpun akan mudah mengerti.

Actual wiring diagram dan diagram sequence

Diagram kabel

Diagram sequence

Merah Biru

AWAS
Lampu 1 Lampu 2

Contact
umum N.C. contact Relay

Coil

Pushbutton

tombol tekan
N.O.  contact

Lampu 1 Lampu 2

jangan menyambungkan dengan terminal 
power supply voltase eksternal 24 V DC 

Catatan) Pada FX-I/O-DEMO2, relay akan 
di aktifkan oleh catu daya 24 VDC 
untuk menyalakan lampu, secara 
umum dijelaskan pada sekuen 
diagram di bawah ini, relay di 
aktifkan oleh 24VDC, dan kontak 
bantu relay akan menghubungkan 
catu daya 100VAC dengan lampu 
sehingga lampu akan menyala 

RA
PB

Catu Daya DC

Saklar tombol tekan Relay coil

BU

RD
Biru

Merah

Catu Daya AC

RA (kontak bantu b)

RA (Kontak Bantu a)
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1.4.2 Mari Pikirkan Contoh Lainnya

Pompa Pengangkat air 
Pompa

Sumur

Tangki

LS2 (N.O. contact)
Mengambang saat saklar OFF
saat tanki penuh.

LS1 (N.C. contact)
Mengambang saat saklar ON
saat tanki kosong.

 Contoh  2  Pengontrolan level air pada tangki
    
     Isi sequence control
(1) Saat Operation switch tertutup, saat air kosong maka Floatless switch akan 

tertutup dan magnetic contactor MC akan aktif untuk menggerakkan motor 
transfer pump. Relay MC didesain untuk menahan status operasinya 
walaupun air pada level menengah.

(2) Saat air penuh, Floatless Switch akan membuka, Relay MC yang tadinya 
terkunci akan lepas atau mati dan pompa transfer akan berhenti.

(3) Jika level air kosong maka pompa transfer akan berputar kembali secara 
otomatis.

M

MC
Magnetic contactor 

Start Saklar

ON

OFF

Transfer pump akan beroperasi pada kondisi air kosong sampai air penuh. 
Dalam keadaan air pada level tengah bergerak menuju level penuh maka 
pompa masih akan berjalan, sedangkan pada posisi air pada level tengah 
bergerak menuju level bawah pompa masih akan berhenti sampai air 
kosong.

Operasi seperti ini disebut operasi hysteresis (behavior history), dan dapat 
mengurangi frekuensi pengoperasian pompa.



16

Power
Supply

Power Control

Start switch

Switch yang terus
menyala walau
sudah tidak ditekan.

Motor

Memicu motor pengangkat oleh MC Drive.*Breaker

Start switch

Penuh PenuhPosisi tengah level air

Operasi

Posisi tengah
level air

Kosong
Posisi tengah
level air

Float switch
LS2
Float switch
LS1
Magnet
switch

Sequence pada bagian ini biasanya diganti dengan PLC.

Rangkaian Self Holding
Rangkaian Self Holding dikatakan membuat rangkaian operasi dengan bypass oleh 
relay dan magnet contactor MC contact pribadi dengan sinyal yang didapatkan dari 
external ke relay dan magnetic contactor MC.
Kemudian rangkaian Self Holding juga dikatakan memiliki fungsi memori seperti 
pengoperasian secara continue pada rangkaian yang seharusnya terpotong ketika 
pushbutton switch tidak lagi ditekan.
Pada contoh ini contact dari magnetic contactor MC yang memicu motor terkoneksi 
secara parallel dengan limit switch LS1.Rangkaian ini disebut rangkaian  Self  Holding.

Limit switch LS2 memiliki peranan untuk memotong rangkaian Self Holding 2 dan 
menghentikan motor pengangkat air, tetapi jika limit switch LS2 ini menggunakan N.C. 
contact, motor pengangkat air dapat berhenti saat koneksi yang buruk dan wiring cross 
sectional didalam rangkaian juga memotong rangkaian Self Holding.

   Diagram sequence

Operasi rangkaian Self Holding

*Breaker        Alat yang memotong aliran 
listrik pada saat aliran 
listrik mengalir abnormal.

*1

*2

*3

N.O. contact Pada saat kering limit
switch beroperasi, 
menutup.

Magnet
Contractor

N.O. contact

Pada saat tanki
penuh switch
beroperasi mem
buka.

N.C. contact

Walaupun limit switch 
LS1 terputus, magnet 
contractor dapat terus 
beroperasi dengan 
rangkaian Self Holding.

MC

MC
M

MC

MC*2

LS2 *3
LS1

*1
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Kategori Produk

Kategori produk

N.O. contact N.C. contact

Sumber DriveFormat 

Horizontal

Format 

Vertikal

Format 

Horizontal

Format 

Vertikal

Pushbutton
switch
(tipe auto-
return)

Manual

Pushbutton
switch
(Tipe 
latched
operation)

ON

OFF
Manual

Thermal
relay
(OCR)

Heater

Operation

Limit
switch
(umum)

Manual

Limit
switch
(Operasi
mekanis) Dog Cam

Auxiliary
switch relay
contact

Electromagnetic

coil

Magnetic
contactor

Timer
(ON delay)

Timer
(OFF delay)

1.5 Mari mengingat kembali simbol-simbol sequence
Daftar simbol-simbol sequence

(JIS C 0617)
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MEMO



Inilah PLC

APA ITU “PLC?"
PLC disebut juga sebagai Programmable Controller (PLC) atau Sequence 
Controller (SQ). PLC adalah sebuah alat yang digunakan untuk mengontrol 
berbagai macam perangkat yang berhubungan dengan input dan output 
dan mempunyai internal memory untuk menyimpan instruksi program.

Pada kenyataannya
Sampai saat ini kita telah melakukan sequence control dengan melakukan 
wiring relay dan timer, bab berikut akan menerangkan penggunaan PLC 
untuk mengkontrol perangkat elektronik.

APA ITU “PLC?"
BAB 2
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2.1 PLC adalah
2.1.1 Apakah PLCs Itu

Didalam  sequence control ”alat yang dioperasikan manusia” dan “alat yang 
mendeteksi kondisi mesin” disebut sebagai instruction signal atau condition 
signal, kemudian “alat yang memberitahukan kondisi mesin pada manusia” dan 
“alat yang menggerakkan mesin” disebut load.

PLCs setara dengan bagian “sequence control” seperti diagram diatas, memiliki 
peranan untuk mengontrol alat ini. Persisnya PLCs adalah alat untuk 
menjalankan sequence control.

Petugas

Saklar, dll Lampu, buzzer, dll.

Motor, katup solenoid, dll.

Alat yang memberitahukan keadaan 
mesin pada petugas

Alat yang dioperasikan
oleh petugas

Sequence control
Alat untuk membuat
mesin bergerak

Mesin

Alat untuk mendeteksi
keadaan mesin

Sensor, dll.
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2.2 Mekanisme PLCs
2.2.1 Bagaimana Sequence Control Dijalankan

PLCs adalah alat mikrokomputer

yang dikendalikan untuk kepentingan industri

Pada PLC terkoneksi condition signal dan instruction signal didalam alat 
disebelah kiri halaman dan disebut drive load. Kemudian alat yang dikoneksikan 
di daerah input disebut “input-device”, sedang alat yang di daerah output disebut 
“output-device”. Input-output device, keduanya dikoneksikan satu persatu pada 
panel terminal PLC.

Pada PLC hanya dengan mengkoneksikan input-output device satu persatu 
seperti ini, serta koneksi untuk menjalankan sequence control dijalankan didalam 
internal PLC secara elektrikal.

Koneksi internal PLC dideskripsikan menggunakan bahasa (instruksi) sequence 
yang khusus. Kumpulan dari instruksi inilah yang disebut program sequence dan 
sequence control dijalankan berdasarkan program ini.

Karenanya tidak dibutuhkan wiring pada external.

Saklar terbatas

Contact Relay

Saklar 
pemilih

Saklar tombol tekan

PLC

Alat input

Handy Programming
panelPC(Software untuk pemrograman)

Power supply

O
ut

pu
t i

nt
er

fa
ce

In
pu

t i
nt

er
fa

ce

Bagian

Penyimpanan

Bagian
Operasi

Memory

Mikrokomputer

Penghubung

 Lampu

Katup solenoid

 (katup solenoid)

Alat output

Power supply
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2.2.2 Secara Actual PLC Bisa Dianggap Sebagai Kumpulan
Relay dan Timer

Input device, output device, program sequence secara riil merupakan struktur diagram diatas.
Input device dikoneksikan dengan input relay PLC’s, sedang output device dikontrol melalui external output contact.

Input relay

Output contact

Input relay memiliki peranan untuk mengkonversi  sinyal  external  device 
menjadi COM  terminal.  Kemudian,  pada  umumnya contact  relay yang  
paling  banyak  sekalipun hanya terdapat beberapa contact  tetapi dengan
program sequence dapat memiliki banyak sekali contact.

Pada internal PLC, memiliki power 
input relay, contact dari input device 
mengkonduksi dan listrik akan 
mengalir seperti garis putus putus 
sehingga input relay akan terpicu.

Jika output relay di program 
Sequence dipicu maka external 
output contact akan menutup. 
Mohon untuk menambahkan power 
untuk mengaktifkan output device 
pada external PLC.

Pada PLC seperti ini, tanpa memperdulikan N.O. contact atau N.C. contact, 
jika external input device mengkonduksi COM dan input terminal maka contact 
yang menutup adalah N.O. contact dan yang membuka adalah N.C. contact.

Output contact adalah contact untuk memicu load external di-output relay yang 
dipicu oleh program sequence. External output contact dapat mengkoneksikan 
berbagai alat power dari AC/DC di unit COM (common).

Input relay dioperasikan
oleh sinyal eksternal

Program sequence dioperasikan
oleh input contact relay

Output dari output
operasi relay

Gerak eksternal 
dioperasikan

Power
supply

PL

Contact untuk
output eksternal 

Relay input

PLC

Operation

Operation

PB1

LS1

PB2

X001

Y000

X001

X005

M100

X007

K100

X003

Relay output

Timers

Auxiliary relay

COM

X000

X001

X002

X003

X004

X005

X006

X007

X001

X003

X005

M100

T0

Y100

Alat input

COM

Input relay

Sequence

Terminal Input

COM

Sequence
Alat output

Power supplyContact untuk output eksternal

Terminal Output

COM1

Y000

Y001

Y002

Y003

MC
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Nomer I/O akan dialamatkan untuk setiap terminal untuk menghubungkan input 
dan output pada terminal dengan input dan output relay pada program sekuens. 
Timer dan counter pada internal PLC juga akan mendapat pengalamatan seperti 
nomer terminal.

Device……Pada device, device distrukturkan dengan simbol device yang menunjukkan 
                   mengapa ada device dan nomer device yang dibedakan satu persatu.
                   (Device disebut juga sebagai nomor elemen).

Input relay berperan sebagai contact point 
untuk menerima sinyal dari input switch di luar 
PLC, X digunakan untuk melambangkan 
nomer device. PLC mempunyai input relay 
internal yang berhubungan dengan nomer 
input pada terminal.

Input relays : X000~X177 (128 poin)

Output relay berperan sebagai contact 
point untuk menggerakkan load diluar 
PLC. Y digunakan untuk melambangkan 
nomer device. PLC mempunyai output 
relay internal yang berhubungan dengan 
nomer output pada terminal.

Output relays : Y000~Y177 (128 poin) 

Timer berada dalam internal PLC, 
timer mempunyai coil dan contact. 
Saat setting time tercapai, contact 
akan menutup.

Timers : T0 ~ T319 (320 poin) 

Counter berada dalam internal PLC, 
saat hitungan nomer tercapai contact 
akan menutup.

Counters : C0 ~ C199 (200 poin) 

Auxiliarry relay terdapat pada internal 
PLC dan biasa disebut internal relay.

Jumlah input relay, output relay, auxiliary relay, timer dan counter yang dapat 
digunakan berbeda, tergantung tipe PLC.        

Auxiliary relays : M0 ~ M7679 (7680poin) 

Referensi

Decimal number, Octal number, Hexadecimal number
Selain menggunakan  decimal number, ada pula device yang menggunakan octal 
number dan  hexadecimal number seperti tabel dibawah ini.

Auxiliary timers, timers, countersInput relays, output relays

General-purpose Q/A Series 
Micro PLC FX Series Octal Decimal

Hexadecimal Decimal

"Decimal"

"Octal"

"Hexadecimal"

metode angka yang umumnya digunakan dengan menaikkan digit  
angkanya tiap 10 poin seperti 0~9, 10~19, 20~29  
Octal number adalah metode angka dengan menaikkan digit angkanya 
tiap 8 poin  seperti 0~7, 10~17, 20~27
metode angka dengan menaikkan digit angkanya tiap 16 poin seperti
0~9, 0A, 0B, 0C, OD, 0E, 0F, 10~19, 1A, 1B, 1C, 1D, 1E, 1F
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2.2.3 Tentang Representasi Diagram Sequence dan Program Sequence
PLC pada program sequence adalah alat yang diganti menjadi rangkaian untuk 
menjalankan sequence control pada input device, output device yang di-wiring pada tiap 
terminal external. Mengenai detail istilah instruksinya silahkan dilihat pada bab 3. 
Cara perubahan ke program  sequence akan dijelaskan pada diagram  di bawah ini. 
Contohnya, kontrol level air pada tangki pada halaman 1-12 yang diganti ke program 
sequence.

Disekitar penggantian akan dijelaskan beberapa poin yang berbeda seperti 
dibawah ini ①. Representasi N.O. contact dan N.C. contact.

SW
LS2 LS1

MC

MC

MC

MC

X000 X002 X001

Y000

Y000
SW LS2 LS1 

Diagram Sequence Program Sequence

(1) Bagaimana N.O. contacts and N.C. contacts diekspresikan
Relay sequence diagram Sequence program
N.O. contact

(2) Power rangkaian tidak direpresentasikan.
(3) Pada program sequence dipasang device (nomor elemen) yang dijelaskan di
      halaman sebelumnya.

(4) Pada diagram sequence LS2 adalah N.C. contact, tetapi pada program 
sequence menjadi N.O. contact. Pertama-tama peranan LS2 pada diagram 
sequence diatas adalah untuk memikirkan hal-hal seperti memutuskan 
rangkaian Self Holding MC, juga untuk menghentikan MC dan rangkaian 
selalu dalam kondisi mengkonduksi.

Penting

N.O. contact

N.C. contact N.C. contact
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Pengoperasian “N.O. contact” dan   “N.C. contact” pada 

Program Sequence
Pengoperasian “N.O. contact” dan“N.C. contact” pada program sequence 
dari input relay pada halaman 2-4 menjadi seperti dibawah ini.  Pada saat 
input device dalam “kondisi non konduksi” terhadap PLC, “N.O. contact” 
menjadi “non konduksi pada program”, sedangkan “N.C. contact” menjadi 
“konduksi” Pada saat input device dalam “kondisi konduksi terhadap PLC”, 
“N.O. contact” menjadi “konduksi pada program” dan “N.C. contact”  “non 
konduksi” Karenanya di PLC, untuk mendapat kondisi operasi yang sama 
dengan diagram sequence pada halaman 1-14, maka perlu menggunakan 
“N.O. contact” terhadap sinyal LS2 pada program sequence. Untuk lebih 
jelasnya silahkan lihat diagram 1 dan 2 dibawah ini.

Referensi

(1) Alasan menggunakan LS2 (X2) sebagai N.O. contact 
Jika membuat contact sama dengan diagram sequence dengan N.C. contact 

	 (2) Jika membuat N.O. contact sebagai contact

●Konsep Program
Saat sinyal dari external di-input, N.O. contact menjadi konduksi dan N.C. contact 
menjadi non konduksi.

Kosong

Kosong

Penuh

N.O. contact

N.C. contact

N.C. contact

N.O. contact 

Bukan
konduksi

konduksi

Tidak
konduksi Konduksi

N.C. contact

N.O. contact 

Mulai

Penuh

Mulai

Kosong

Kosong

Pernyataan konduksi 
ditransfer sebagai 
sinyal “ON”.

Pompa dalam
keadaan OFF.

Pompa 
ON.

arus listrik tidak mengalir
saat contact ON.

Aliran listrik mengalir ketika 
contact menyala ON.
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Kosong

Penuh

Kosong

Penuh

Mulai

Kosong

Penuh

Mulai

Kosong

Penuh

Mulai

Kosong

Penuh

Mulai

Pompa
 OFF.

Pompa
OFF.

Pompa
menyala 

ON.

Pompa
menyala

ON.

Saklar menyala ON 1 kali
pompa menyala ON.

Saklar OFF 1 kali, pompa
tetap menyala ON dengan 
fungsi self-holding.

Saklar menyala ON 2 kali, 
pompa menjadi OFF.

[2] Aliran kontrol level air pada tangki 

•	  Pompa mati (OFF) ketika posisi air di tengah.

•	 Saat level air pada tangki dalam kondisi kering.

•	 Dalam water supply, pompa ON.

•	 Saat level air pada tangki dalam kondisi penuh.
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2.3 Wiring dan Program
2.3.1 Bagaimana Wiring dan Program pada PLC
Diagram dibawah ini adalah diagram  rangkaian dari halaman 1-13 yang telah 
dianalisis.

Input-output wiring Memerlukan 
pekerjaan konvensional dengan 
menggunakan tang dan obeng.

Kemudian koneksi antara input internal dan input relay coil, koneksi external 
output contact pada output relay dan output terminal sudah diselesaikan pada 
tahap pengiriman pabrik.

Internal wiring yang rumit (sequence 
program) dapat dilakukan dengan 
mudah dengan operasi keyboard 
menggunakan PC atau programming 
tool.

SW

COM

X000

COM

Fuse

Y000 MC
X000 X002 X001

Y000

Y000

X001

X002

LS1

LS2

Output wiringSequence programIntput wiring

Wiring pada PLC dibagi menjadi input-output wiring dan internal wiring
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2.4 Keuntungan Menggunakan PLC
2.4.1 Efisiensi Penggunaan PLC

1 Ekonomi
PLC lebih ekonomis daripada panel control konvensional yang
menggunakan lebih dari 10 buah relay, timer dan lainnya.

2 Labor Saving Design
Labor saving design dicapai dengan penyederhanaan diagram wiring 
pada perangkat component, kemudahan design sequence serta 
kemudahan commissioning.

3 Pengurangan Jumlah Pekerjaan
Jumlah pekerjaan dikurangi dengan pengurangan pengaturan pada component, 
pengaturan parallel alat mesin dan control panel, fleksibilitas terhadap perubahan
spesifikasi dan penyederhanaan pekerjaan wiring.4 Kecil・Standarisasi
Dibandingkan relay panel dimensi control panel diperkecil secara signifikan
serta dapat dijalankan standarisasi reuse program untuk mass production.

6 Memudahkan Maintenance
Maintenance dapat dilakukan dengan mudah karena sedikitnya parts 
lifespan dan penambahan diagnosa kerusakan.

5 Peningkatan dalam ketahanan
Berkurangnya trouble pada relay, timer dan jika pengaturan awal telah 
usai maka dapat digunakan dengan tenang.

2.4.2 Perbandingan Dengan Relay Control

Sejarah Pendek mengenai PLC
Sesuai dengan permintaan development dari GM (General Motor), 
Inc dari Amerika Serikat, pada tahun 1968 PC muncul, dan mulai 
dijual secara umum di Amerika pada tahun 1969. Di Jepang, 
domestic machine muncul pada tahun 1970, sedang Multipurpose 
machine muncul setelah tahun 1976. Mitsubishi electric yang 
memulai penjualan multipurpose machine pada tahun 1977, dan 
meluncurkannya dengan tipe one board ke pasaran. Setelah itu, 
pada tahun 1980 meluncurkan multipurpose machine K series yang 
dilengkapi dengan fungsi pengaturan numerical value,dan pada 
tahun 1981 akhirnya meluncurkan Micro PLC F series yang 
dilengkapi dengan programmer dan senilai lebih dari 100 ribu yen, 
dan memasuki periode penyebaran PLC asli.

1
2
3
4
5
6
7
8
9

PLC controlMetodeItem Relay control

Fungsi

PLC dapat digunakan oleh berbagai 
macam kontrol tergantung pada 
programnya.

Sekali dibuat, alat tidak dapat 
digunakan pada device yang
lain.

Kemungkinan isi
control

PLC dapat diperbaiki dengan 
mengganti unit.

PLC dapat dengan bebas 
diperluas seluruh 
kemampuan potensialnya.

Bila terjadi penambahan dan 
modifikasi membutuhkan 
tambahan yang rumit.

Kontrol analog dan penempatan 
dapat ditambahkan di dalam 
program sequence.

PLC dengan kerumitan tinggi 
pun tetap kecil.

Desain tetap simpel walaupun 
kontrol rumit, tidak membutuhkan 
manufaktur yang lama.

Membutuhkan banyak rencana dan 
memerlukan waktu untuk mengatur 
onderdil dan perakitan.

Hanya mendukung kontrol 
relay.

Memerlukan penggantian 
umur onderdil dan servis 
berkala.

Kontrol dapat diprogram 
sekompleks apapun.

Hanya program yang butuh 
diganti sedangkan kontrol 
bebas diganti.

Tidak ada opsi lain selain 
merubah wiring.

Reabilitas tinggi karena 
bagian intinya semi 
konduktor.

Tidak ada masalah pada saat 
penggunaan biasa, tetapi tedapat 
batasan umur dan gagal koneksi.

Inspeksi berkala dan 
keterbatasan servis untuk 
onderdil ketika mengganti.

Berukuran besar.

Referensi

Reabilitas

Keanekaragaman

Kemungkinan isi
control

Ekspansi alat

Kemudahan perawatan

Ukuran alat

Waktu desain,
manufaktur
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2.4.2 Perbandingan Dengan Relay Control

Sejarah Pendek mengenai PLC
Sesuai dengan permintaan development dari GM (General Motor), 
Inc dari Amerika Serikat, pada tahun 1968 PC muncul, dan mulai 
dijual secara umum di Amerika pada tahun 1969. Di Jepang, 
domestic machine muncul pada tahun 1970, sedang Multipurpose 
machine muncul setelah tahun 1976. Mitsubishi electric yang 
memulai penjualan multipurpose machine pada tahun 1977, dan 
meluncurkannya dengan tipe one board ke pasaran. Setelah itu, 
pada tahun 1980 meluncurkan multipurpose machine K series yang 
dilengkapi dengan fungsi pengaturan numerical value,dan pada 
tahun 1981 akhirnya meluncurkan Micro PLC F series yang 
dilengkapi dengan programmer dan senilai lebih dari 100 ribu yen, 
dan memasuki periode penyebaran PLC asli.

1
2
3
4
5
6
7
8
9

PLC controlMetodeItem Relay control

Fungsi

PLC dapat digunakan oleh berbagai 
macam kontrol tergantung pada 
programnya.

Sekali dibuat, alat tidak dapat 
digunakan pada device yang
lain.

Kemungkinan isi
control

PLC dapat diperbaiki dengan 
mengganti unit.

PLC dapat dengan bebas 
diperluas seluruh 
kemampuan potensialnya.

Bila terjadi penambahan dan 
modifikasi membutuhkan 
tambahan yang rumit.

Kontrol analog dan penempatan 
dapat ditambahkan di dalam 
program sequence.

PLC dengan kerumitan tinggi 
pun tetap kecil.

Desain tetap simpel walaupun 
kontrol rumit, tidak membutuhkan 
manufaktur yang lama.

Membutuhkan banyak rencana dan 
memerlukan waktu untuk mengatur 
onderdil dan perakitan.

Hanya mendukung kontrol 
relay.

Memerlukan penggantian 
umur onderdil dan servis 
berkala.

Kontrol dapat diprogram 
sekompleks apapun.

Hanya program yang butuh 
diganti sedangkan kontrol 
bebas diganti.

Tidak ada opsi lain selain 
merubah wiring.

Reabilitas tinggi karena 
bagian intinya semi 
konduktor.

Tidak ada masalah pada saat 
penggunaan biasa, tetapi tedapat 
batasan umur dan gagal koneksi.

Inspeksi berkala dan 
keterbatasan servis untuk 
onderdil ketika mengganti.

Berukuran besar.

Referensi

Reabilitas

Keanekaragaman

Kemungkinan isi
control

Ekspansi alat

Kemudahan perawatan

Ukuran alat

Waktu desain,
manufaktur
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MEMO



 Mari membuat program dengan PC

Jika menggunakan PC, Sequence itu mudah 
Software GX Works2 mudah digunakan dan efisien untuk membuat atau 
merubah program sekuens pada PLC. Setelah operasi dasar dikuasai 
programming sering menggunakan pengulangan yang berkelanjutan. Mulai 
dengan operasi yang paling sering digunakan, mari kita belajar cara membuat 
program dari dasar. 

Membuat Project Baru dan Update Dengan Mudah 
Di dalam program, dilengkapi dengan debug. Karena kondisi pengoperasian 
program dan PLC dapat dimonitor pada layar, pengaturan dan pemastian 
kembali bagian yang beroperasi tidak sesuai harapan dapat segera dilakukan.

Melihat program dengan mudah 
Pada GX Works2 terdapat "Comment Input Function" untuk memudahkan 
melihat program sequence. Jika meng-input comment efisiensi pembuatan dan 
debug sequence program meningkat. 

PENGOPERASIAN GX Works2 
BAB 3
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3.1 Pengetahuan Dasar untuk Pengoperasian 
Programming Software 
3.1.1 Struktur Layar pada Programming Software 

1) Title bar
Menampilkan tampilan project name yang sedang terbuka dan icon operasi pada windows.

1) Title bar

4) Status bar

Perubahan size windows, shutdown

menampilkan nama proyek mengecilkan GX Works2 Menutup GX Works2

Pembesaran dan pengecilan windows

2) Menu bar

6) Tampilan edit

3) Toolbar

5)Jendela Navigasi
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2) Menu bar

Ketika memilih menu, maka menu drop down akan ditampilkan.

3) Toolbar*

*  Konten dari toolbar bisa dipindah, ditambah atau dihapus, sehingga Layout dan item yang 
ingin ditampilkan bisa diubah sesuai keinginan.

Fungsi yang sering digunakan ditempatkan pada icon button untuk memudahkan 
penggunaan. Deskripsi dari fungsi button tersebut akan tampil apabila kursor diletakkan 
pada button tersebut.

Ketika 
menempatkan 
kursor mouse 
pada tombol, 
maka isi fungsi 
akan ditampilkan

4) Status bar
   Status operasi dan setting keyboard akan ditampilkan. 

Menampilkan input mode yang sedang dikerjakan

 Status Scroll Lock

Tipe 
CPU

Status 
Caps Lock

Lokasi
CPU yang 
terhubung

Status 
Num Lock
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6) Tampilan edit

5) Navigation window

Diagram rangkaian sequence 
akan ditampilkan bila [POU] → 
[Program] → [MAIN] di-klik.

Klik pada mouse, susunan konten 
dari "project" akan tampil pada 
permukaan.

Klik pada mouse, akses poin pada 
komputer (sambungan PLC) akan 
ditampilkan.

Tab untuk ganti.
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3.1.2 Tentang Workspace dan Project 

Project

Program

Device comment

Parameter

Device memory

Setara dengan folder di dalam Windows®.

Program Sequence 

Comments untuk devices

Parameter data setting untuk PLC

Isi dari nilai device yang sekarang atau
yang telah di-input

Setara dengan folder di dalam Windows®.Workspace

zzWorkspace
Workspace adalah alat untuk mengatur multiple program dalam satu nama oleh GX 
Works2. Jangan mengubah struktur pada workspace, seperti pada Windows® Explorer.

zzProject
adalah kumpulan program, device comment, parameter dan device memory. 
Pada GX Works2 kumpulan data seri disebut "Project", dan akan disimpan dalam 
folder workspace name. 

ketika menyimpan di format workspace
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3.2 Memulai GX Works2 and membuat project baru
3.2.1 Memulai GX Works2

1) Mulai dari tombol Start Windows®, dan pilih 
aplikasi sesuai urutan berikut :

2) GX Works2 telah dibuka.

[GX Works2]

[MELSOFT Application]

[Programs]
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1) Pilih  dari toolbar, atau pilih [Project] 
→ [New] ( Ctrl + N ) dari menu.

3.2.2 Membuat project baru

2) Klik tombol [▼] dari [Series].

3) pilih "FXCPU".

4) Klik tombol [▼] pada [Type].

5) Pilih "FX3G/3GC".

(catatan) Pilih nama seri yang sebenarnya  
               digunakan.

1) Klik

2) Klik

4) Klik

3) Pilih dan klik

5) Klik dan pilih

1) Klik
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6) Klik OK .

(Catatan) Pilih "Simple Project" dari "Project Type". 
    Jangan beri tanda cek pada "Use Label". 
    Pilih “Ladder” dalam “Language”.

7) Layar project yang baru tampil untuk 
memasukkan input project data yang 
baru.

6) Klik

7) Layar project baru
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3.3 Membuat Rangkaian
3.3.1 Pembuatan Rangkaian Menggunakan Tombol Fungsi 

[Rangkaian yang akan dibuat] 

X002
Y000

Y000

X000

X003
Y001

Hubungan tombol fungsi dan nomor rangkaian ditampilkan pada tombol toolbar.

POIN

F5 F6 F7

F8

F9

F5

Shift Shift

F6

Shift

F9

Ctrl

F10

F9

Ctrl
+

++++

POIN
Di buku ini, input dan output nomor 
relay ditampilkan dengan tiga 
digit,seperti "X000," dan
"Y000." Saat menggunakan GX 
Works2, dapat menggunakan input, 
"X0," "Y0,"

Kunci operasi utama

  • "N.O. contact " and "Coil (    　　)(　) , (    　　)[　] " dapat diinput langsung tanpa menggunakan  
    shortcut pada keyboard. 
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6) Ladder input
X0

ditampilkan. 

7) Tekan tombol F7 .
    masukkan "Y0".

8) Konfirmasi dengan menekan tombol Enter  
atau [OK].

9) Ladder input  ditampilkan.

10) Tekan tombol Shift  + F5  . 
  Masukkan "Y0".

11) Konfirmasi dengan menekan tombol 
Enter  atau [OK].

3) Ladder input 
X2

ditampilkan.

4) Tekan tombol F6 .
    masukkan "X0".

5) Kofirmasi dengan menekan tombol Enter  
key atau [OK].

1) Tekan tombol F5  . 
Input "X2".

Untuk membatalkan tekan ESC  atau [Exit].

2) Konfirmasi menggunakan tombol Enter  
atau OK.

1) Input “X2”

4) Masukkan “X0”

7) Masukkan “Y0”

10) Masukkan “Y0”

3) Elemen "ladder" ditampilkan

6) Elemen "ladder" ditampilkan

9) Elemen "ladder" ditampilkan

2)  Tekan tombol Enter  

5) Tekan tombol Enter  

8) Tekan tombol Enter  

11) Masukkan tombol Enter
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12) Ladder input
Y0

 Y0 ditampilkan.
13) Gerakkan kursor pada awal garis 

selanjutnya.

14) Tekan tombol F5 . 
masukkan"X3".

15) Konfirmasi dengan menekan tombol 
Enter  atau [OK].

16) Ladder input
X3

ditampilkan.
17) Tekan tombol F7 . 

Masukkan "Y1".

18) Konfirmasi dengan menekan tombol 
Enter  atau [OK].

19) Ladder input ditampilkan.
.

F4 (Build)

Tamp i l an war na abu - abu mengh i l ang , 
rangkaian ditetapkan. Ketika terjadi kesalahan, 
arahkan kursor pada bagian yang salah dari 
rangkaian yang dibuat dari koreksi rangkaian.

20) Operasi Perubahan Rangkaian (Penting) 

       Jalankan operasi F4 (Conversion) 	
untuk menetapkan diagram rangkaian 
yang belum ditetapkan (Bagian dengan 
warna abu-abu). 
 
Tekan tombol F4 (Build) atau pilih  
dari toolbar, atau pilih [Compile] → 
[Build] dari menu.

14) Masukkan “X3 ”

17) Masukkan  “Y1”

12) Elemen "ladder" ditampilkan

16) Elemen "ladder" ditampilkan

13) Gerakkan kursor

15) Masukkan tombol Enter

18) Tekan tombol Enter

20) Tampilan warna abu-
abu menghilang

19) Elemen "ladder" ditampilkan
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3.3.2 Membuat program menggunakan tombol pada toolbar

[Program yang akan dibuat]

Klik pada tombol toolbar 

POIN

X002
Y000

Y000

X000

X003
Y001

POIN  
Di buku ini, input dan output nomor 
relay ditampilkan dengan tiga 
digit,seperti "X000," dan
"Y000." Saat menggunakan GX 
Works2, dapat menggunakan input, 
"X0," "Y0,"

Tombol-tombol utama pada toolbar
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6) Input Ladder 
X0

ditampilkan.

7) Klik pada tombol toolbar  . 
Masukkan "Y0".

8) Konfirmasi gunakan Enter  atau [OK].

 

 9) Input Ladder ditampilkan.

10) Klik pada tombol toolbar  . 
Masukkan"Y0".

11) Konfirmasi gunakan Enter  atau [OK].     

batalkan dengan ESC  atau [Exit].

3) Input Ladder 
X2

ditampilkan.

4) Klik pada tombol toolbar  . 
Masukkan "X0".

5) Konfirmasi gunakan Enter  atau [OK].

2) Konfirmasi gunakan Enter  atau [OK].

1) Klik the toolbar button . 
Input "X2".

1) Masukkan “X2”

4) Masukkan  “X0”

7) Masukkan “Y0”

10) Input “Y0”

2) Klik

5) Klik

8) Klik

11) Klik

3) Elemen "ladder" ditampilkan

6)  Elemen "ladder" ditampilkan

9) Elemen "ladder" ditampilkan
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12) Ladder input
Y0

ditampilkan.
13) Gerakkan kursor pada garis permulaan 

teks.

14) Klik tombol toolbar . 
masukkan"X3".

15) Konfirmasi dengan Enter  atau [OK].

16) Ladder input
X3

ditampilkan.

17) Klik tombol toolbar  . 
masukkan "Y1".

18) Konfirmasi dengan Enter  atau [OK].

19) Ladder input ditampilkan.

F4 (Build)

Tamp i l an war na abu - abu mengh i l ang , 
rangkaian ditetapkan. Ketika terjadi kesalahan, 
arahkan kursor pada bagian yang salah dari 
rangkaian yang dibuat dari koreksi rangkaian

20) Operasi Perubahan Rangkaian (Penting) 

       Jalankan operasi F4 (Conversion) 	
untuk menetapkan diagram rangkaian 
yang belum ditetapkan (Bagian dengan 
warna abu-abu). 
 
Tekan tombol F4 (Build) atau pilih  
dari toolbar, atau pilih [Compile] → 
[Build] dari menu.

17) Masukkan“Y1”

14) Masukkan“X3”

18) Klik

15) Klik

12) Elemen "ladder" ditampilkan

16) Elemen "ladder" ditampilkan

19) Elemen "ladder" ditampilkan

  20) Tampilan warna abu-abu         
----  .menghilang.

13) Gerakkan kursor
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3.4 Menulis programs untuk PLC
Writing program sequence yang telah dibuat pada FX PLC.

3.4.1 Menghubungkan PC dengan PLC 
Koneksi dengan PLC FX3G (Koneksi dengan kabel USB) 
[Persiapan pada bagian PC] 
Untuk mengkoneksikan PC dan PLC FX3G dengan kabel USB, perlu menginstal USB drive 
software pada PC. Cara menginstal drive software, dapat dilihat pada manual berikut.

[GX Works2 Operating Manual (Common edition)] 

[Diagram koneksi]

 

PLC
built-in port
(USB)

Kabel USB 

USB

GX Works2

[Jika menggunakan Windows® 7 dan Windows® 8]
1. Hubungkan PC dan PLC dengan kabel USB, kemudian nyalakan PLC.
2. Dari Windows® control panel, pilih [ System and Security] – [ Device Manager ] lalu klik kanan 
    “Unknown device” dan klik “Update Driver Software”.
3. Tampilan Update Driver Software akan ditampilkan. Pilih “ Browse my computer for driver ---.  
--- software ” dan spesifikasi “ Easysocket\USBdrivers ” pada folder dimana GX Works2 telah
--- diiinstal pada layar yang ditampilkan. Jika beberapa produk MELSOFT telah diinstal ---.-----.--.  
--- sebelumnya, silahkan merujuk pada lokasi yang telah diinstal.

*Instalasi dengan drive USB berbeda jika menggunakan FX3U-USB-BD dan FX-USB-AW.  
Metode instalasi juga berbeda tergantung dengan PC nya. Lebih lengkapnya harap melihat pada 
“GX Works2 Operating Manual (Common). 

Poin Instalasi dengan drive USB
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3.4.2 [Connection Destination Setting] pada Programming

 Software
Menjalankan setting untuk mentransmisikan PLC dengan GX Works2. 

3) Transfer Setup ditampilkan.

4) Dobel klik pada ikon .

5) Jalankan setting pada port pentransmisi 

    pada bagian PC. 

    Ketika mengkoneksikan port USB internal

    pada PLC FX3G, pilih [USB]. 

6) Setelah setting selesai klik [OK].

7) Klik tombol [Connection test], 

    pastikan transmisi dengan PLC. 

8) Klik [OK] setelah memastikan, tetapkan isi 

    setting. 

1) Klik "Connection Destination".

2) Dobel klik "Connection1".

3) Transfer Setup ditampilkan

4) Dobel klik

6) klik

5) klik

7) klik

8) klik

2) Dobel klik

1) Klik



47

9) Setting switch [RUN/STOP] pada PLC 
    menjadi [STOP] . [Item tambahan: Fungsi auto 

RUN/STOP pada programing software].

- Apabila writing dijalankan ketika squencer dalam 
kondisi RUN, maka setelah operasi. 

- Message [After STOP remote, Execute PC Writing?] 
ditampilkan. Klik [Yes(Y)] untuk menjalankan 
writing. 

- Setelah writing selesai, message [PC in STOP 
condition. Execute RUN remote?] ditampilkan.
Untuk membuat PLC dalam keadaan RUN klik 
[Yes(Y)].

11) Klik [Parameter + Prog].

12) Klik  [Execute]. 
  (Lihat item tambahan 9 ).

10) Pilih  dari toolbar, atau pilih [Online] →
      [Write to PLC] dari menu. 

13) Setelah selesai klik [Close]. 

1) Set untuk 
    "STOP"

Ditampilkan dialog box yang menampilkan 

proses writing.

10) Klik

12) Klik

13) Klik

Proses penulisan

11) Pilih data yang 
akan ditulis
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3.4.3 Monitor Operating pada Program 

1) Setting switch [Run/Stop] di PLC 

    menjadi [Run]. 

.

Cek operasi menggunakan mode monitor

2) Jalankan operasi berikut ini:

•	Klik --->  F3 (Monitor Mode).

•	Klik  pada toolbar.

•	Pilih [Online] → [Monitor] → [Start 
Monitoring(All Windows)] pada menu.

1) Set untuk 
    "RUN"

1) Ketika kondisi [Switch X000 dalam posisi "OFF"], ["ON" kan Switch X002] dan pastikan 
[Output Y000 pada posisi "ON"]. 

2) Walaupun [meng-"OFF"-kan Switch X002] pastikan [Output Y000 sedang dalam posisi 
"ON"]. 

3) Ketika [Meng-"ON"-kan Switch X000] pastikan [Output Y000 dalam posisi "OFF"]. 

4) Sambungkan ["ON/OFF" pada Switch X003], pastikan [Output Y001 dalam posisi "ON/
OFF"]. 

2) Klik
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1)	Tampilan GX Works2 

2) 4)3) 1)

 
 
 
 
 
 
 
 
 
 
 

2)	Perspektif tampilan kondisi monitor rangkaian

Referensi

1)	Scan Time - Menampilkan scan time 
maksimal pada program sequence. 

2)	Kondisi PLC - Menampilkan kondisi 
PLC. Tanda "

▲

" menunjukkan PLC 
dalam kondisi "RUN", 	 tanda " ■" 
menunjukkan PLC dalam kondisi "STOP". 

3)	Status ERR (PC diagnosis), Dengan klik 
bisa memastikan detail.

4)	Tampilan isi memori -Menunjukkan 
memori PLC. 

1. Instruksi Contact 
Input contact

Tipe
X0 : OFF X0 : ON

N.O. contact 
X000

Rangkaian non 

X000

Rangkaian konduksi 

N.C. contact
X000

Rangkaian konduktif 

X000

Rangkaian non 

2.Instruksi Output 
Driving status

Tipe
Saat non-execution/

Non-drive
Saar execution/Drive

Instruksi OUT
Y000 Y000

SET instruction, etc.
SET M0 SET M0

Pada instruksi RST, device yang ter-reset dalam kondisi ON/OFF ditampilkan 
pada monitor.

Device status
Tipe

Saat device yang di-
reset kondisi OFF

Saat device yang di-
reset kondisi ON

Instruksi RST 
RST M0 RST M0
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3.5 Edit pada Rangkaian 
3.5.1 Koreksi pada Diagram Rangkaian 

Huruf yang digunakan untuk menginput adalah alphabet half width character. Tidak bisa 
menggunakan full width character. 
• Mengubah "Overwrite" dan "Insert" 

- Untuk mengedit rangkaian yang sudah ada, jalankan "Overwrite" mode 
- Apabila menyeting dengan"Insert" mode, maka akan di-insert sebagai tambahan -----------              
  rangkaian yang berbeda. 

Poin

Ganti
"Overwrte" dan "Insert"

dekan menekan Insert key.
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[1] Mengubah OUT Coil dan Nomor Contact 

[Rangkaian yang dikoreksi] 

4) Hasil yang telah dikoreksi dan blok 
rangkaian ditampilkan dengan warna abu-
abu. 

1) Dobel klik pada bagian yang akan 
dikoreksi.

5) konfirmasi dengan F4  (Build) key.

2) Ubah "Y001" menjadi "Y002". 

3) Konfirmasi dengan Enter  atau [OK].

5) F4 (Build)

X002

Y000

X000

X003
Y001

Y002

Ganti menjadi

Y000

2) Ganti"Y002"

1) Dobel klik

4) hasil koreksi ditampilkan

3) Tekan Enter



52

[2] Penambahan garis

[Rangkaian yang akan ditambah garis] 

3) Border akan ditambahkan pada posisi yang 
di-drag. 

4) Arahkan kursor pada posisi OUT Coil 
ditambahkan, dan klik   pada toolbar.

1) Klik  ( F10 ).

X002

Y000

X000

X003
Y002

Tambahkan garis 
vertikal/horizontal
dan buat OUT coil.

Y000

Y003

2) Arahkan kursor pada bagian kanan atas 
dari vertical line yang akan ditambahkan, 
drag ke posisi akhir dan lepaskan. 

5) Input "Y3".

6) Konfirmasi dengan Enter  atau [OK].

1) Klik

2) Drag

Garis telah ditambahkan

5) Ganti "Y3"

4) Posisi kursor

Arahkan kursor pada bagian kanan atas dari 
Posisi line vertikal awal.

6) Tekan Enter
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8) Tetapkan perubahan isi dengan menekan 

    Tombol F4 .

7) Blok rangkaian akan ditampilkan dengan 
warna abu-abu ketika penambahan selesai 
dilakukan. 

 8) F4 (Build)

•  Klik kembali  pada toolbar untuk 
menyelesaikan operasi.

Menambahkan garis menggunakan tombol
Pada GX Works2, dengan tombol pengoperasian Ctrl  + , , ,  . Dapat 
digunakan untuk menambah dan menghapus border.

Referensi

 7) Ladder yang ditambahkan

     telah lengkap
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[3] Menghapus Garis

[Program dengan garis yang akan dihapus]

3) Garis telah dihapus.

4) hapus OUT coil menggunakan Delete .

1) Klik  ( Alt + F9  ) pada toolbar.

X002

Y000

X000

X003
Y002

Menghapus
garis

Y000

Y003

2) Arahkan kursor pada bagian kanan atas 
dari line vertical yang akan dihapus, drag 
ke posisi akhir dan lepaskan. 

3) Garis telah dihapus 

1) Klik

4) hapus menggunakan Delete 

Arahkan kursor pada bagian kanan atas 
dari posisi line yang akan dihapus. 

2) Drag
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5) Blok rangkaian yang sudah dihapus 
ditampilkan dengan warna abu-abu. 

.

6) Konfirmasi dengan F4 (Build).

6) F4 (Build)

•	Klik kembali  pada toolbar untuk 
menyelesaikan operasi.

Menghapus garis menggunakan tombol
Pada GX Works2, garis dapat dihapus menggunakan Ctrl  + , , , . Dapat 
digunakan untuk menambah dan menghapus border.

Referensi
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3.5.2 Memasukkan dan Menghapus Line 

[1] Insert Line 

[Rangkaian yang akan dimasukkan line-nya] 

X002

Y000

X000

X003
Y002

Tambahkan
rung ini

X001

Y000

Y001

1)	Letakkan kursor pada line bagian bawah 
yang akan di-insert. 

Untuk line, arahkan kursor pada bagian atas 
line yang akan di-insert.

Pilih "Insert Row"

2) Klik kanan

3) Line baru 

2)	Klik kanan pada mouse di bagian      
manapun, Pilih [Edit] → [Insert Row].

3)	Insert line selesai.

4)	Tambah program pada line yang telah di-
insert. 

X001
Y001

 

5)	Konfirmasi dengan Build  (F4) key.

4) Tambahkan  ladder

   1) Arahkan kursor pada bagian 
atas line yang akan di-insert 
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[2] Menghapus line

[Line yang akan dihapus]

3) Line telah dihapus.

1) Arahkan kursor pada line yang akan 

dihapus.

2) Klik kanan pada mouse dibagian 

---manapun, Pilih [Edit] → [Delete Row]. 

Pada saat delete line, walau warna abu-
abu tidak ditampilkan, tekan Build  (F4). 
Untuk memastikan isi.

Poin

X002

Y000

X000

X003
Y002

Hapus baris ini

X001

Y000

Y001

1) Gerakkan kursor pada 
line yang akan dihapus

2) Klik kanan 
---.pada mouse

3) Line telah dihapus

Pilih "Delete Row"
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3.5.3 Cut dan Copy (Paste) Rangkaian 

[1] Cut

[Rangkaian yang akan di-edit] 

3) Pilih   dari toolbar dan pilih [Edit] → [Cut] 
( Ctrl  + X  ) dari menu kemudian jalankan 
cut.

1) Arahkan kursor pada bagian awal ladder 
yang akan dipotong. 

X002

Y000

X000

X001

Y000

Y001
Cut baris ini

2) Drag keposisi akhir dan lepaskan.

4) Apabila salah satu bagian rangkaian telah 
terpotong, karena warna abu-abu akan tetap 
tersisa, konfirmasi dengan F4  (Build) .

2) Arahkan kursor sampai 
pada posisi yang diinginkan 
kemudian lepaskan.

3) Jalankan cut

4) Area terpilih telah dipotong

Area cut dan copy

1) Arahkan kursor pada 
bagian awal
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[2] Copy (Paste) 

3) Pilih  dari toolbar atau pilih [Edit] → 
[Copy] ( Ctrl + C ) dari menu.

2) Drag ke posisi terakhir dan lepaskan.

5) Pilih  dari toolbar atau pilih [Edit] → 
[Paste] ( Ctrl + V ) dari menu.

 
Apabila salah satu bagian rangkaian telah 
di-paste, karena warna abu-abu akan 
tersisa, tetapkan dengan menekan tombol 

F4 (Build) key.

1) Arahkan kursor pada awal ladder yang 
akan di-copy. 

4) Arahkan kursor pada posisi yang akan di-
paste.

Pergantian tombol Insert
“Overwrite” Mode : Posisi kursor akan di-
paste-kan pada save.
“Insert” Mode : Di-insert pada bagian atas	
posisi atas kursor.

Poin

Y000

X000

X002
Y000

Copy 
baris ini

X002
Y000

Y000

X000 Paste ke
baris ini

[Rangkaian yang akan di-copy (paste)]

2) Drag ke posisi terakhir dan 
lepaskan3) Jalankan  copy

4) Arahkan kursor pada 
posisi paste

1) Arahkan kursor pada awal 
ladder yang akan di-copy

5) copy/paste selesai



60

3.6 Menyimpan Rangkaian yang Telah dibuat 
3.6.1 Save dan Save as

Poin

1) Pilih   dari toolbar atau pilih [Project] → 
[Save] ( Ctrl + S  ) atau [Save As] dari menu.   

(Ketika file baru disimpan)

Apabila ada ladder yang belum dicompile pada program, setelah pengoperasian tekan  Build  (F4).

(Untuk Overwrite)

Saving Program selesai

2) Tentukan lokasi untuk penyimpanan project.

3) Tentukan nama file.

4) Tentukan deskripsi file (opsional).

5) Klik Save .

6) Klik Yes .
6) Klik

4) Tentukan deskripsi (opsional).

3) Tentukan nama file 

2) Tentukan tempat 
penyimpanan.

1) Klik

5) Klik
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3.6.2 Membaca project

1) Pilih  dari toolbar atau pilih [Project] → 
[Open] ( Ctrl + O  ) dari menu.

Apabila ada project lain yang terbuka pada saat reading operation, project tersebut dapat ditutup.
Akan ditampilkan warning message apabila ada rangkaian yang tidak berubah pada project dan 
belum tersimpan.

Referensi

2) Pilih tujuan penyimpanan file.

3) Pilih project yang akan dibaca read.

4) Klik Open untuk membaca project.

	

2) Pilih lokasi 
penyimpanan

3) Pilih file yang akan 
dibaca

1) Klik

4) Klik
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3.7 Debug Program 
Tentang koneksi pada PLC dan writing program, silahkan merujuk pada “Writing program ke PLC”.

3.7.1 Rangkaian monitor
Memonitor kondisi konduksi pada contact dan kondisi drive coil melalui tampilan rangkaian. 
(Mengenai isi tampilan silahkan merujuk pada “Monitor Operating pada Program”).

2) Pada window monitor rangkaian, 
ditampilkan kondisi ON/OFF rangkaian 
dan current value dari word device (Timer, 
Counter, Data Register).

1) Pilih  dari toolbar atau pilih [Online] → 
[Monitor] → [Start Monitoring(All Windows)] 
dari menu.

Referensi 
• Pada GX Works2 untuk menghentikan monitor, pilih   (Stop monitor), atau [Online] → [Monitor] 
→ [Stop monitor]. Pengeditan rangkaian tetap dapat dilakukan dalam kondisi monitor terhenti.
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3.7.2 Device Registration Monitor
Menentukan satu device atau satu range pada rangkaian window monitor, kemudian 
meregistrasikan device yang ada di bagian ini pada view window.

5) Pada kolom kosong “Device/Label” yang 
kosong dapat diinput secara langsung 
device name “X0”, “M0”, “D0” dll.

6) Pada kolom kosong “Device/Label” yang 
kosong dapat diinput secara langsung 
device name “X0”, “M0”, “D0” dll.

7) Dari Menu  pilih  [Online] → [Monitor]→ 
[Start Monitoring].

1) Kondisikan pada monitor rangkaian 
(Merujuk pada [Rangkaian Monitor ] 
sebelumnya).

4) Device yang telah dipilih teregistrasi pada 
watch window.

2) g Apabila meregistrasi satu device, pilih 	
	 dengan mengklik mouse pada device.
g Apabila meregistrasi multiple device, klik 	
	 dan reverse mouse pada range tersebut.

3) Drag dan drop device yang telah dipilih

    pada watch window.

2) Saat registrasi satu 
device

2) Untuk registrasi 
multi devices

5) Registrasi telah 
selesai

4) Device yang telah dipilih 
teregistrasi pada watch 
window.

7) Saat [Start Monitoring] 
terpilih,current values menampilkan 
(Bit devices: 1 (= ON) or 0 (= OFF), 
word devices: current value)

Drag mouse pada area ini.

6) Input langsung

3) Pilih Watch window
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3.7.3 Device  Batch Monitor
Menetapkan nomor device awal dan memonitoring device secara berturut-turut.

1) Kondisikan pada monitor rangkaian 
(Merujuk pada [Rangkaian Monitor] 
sebelumnya). 

3) Input nomor device awal yang dimonitor 
pada window [Device Batch Monitor], tekan 
tombol Enter . 

      (Catatan) Apabila akan menentukan Time, Counter,         
                    klik [Reference] dan tentukan [MAIN] 
                    pada item program.

4) Respon pergerakan kondisi dari operasi 
device ditampilkan. 

• Bit devices (X, Y, M and S): 1 (= ON) or 0 (= OFF).

• Untuk Timers and counters: ON/OFF status, 

   set value and current value of contact/coil.

• Data registers: Current value.

5) Setelah memilih bagian yang menampilkan 
monitor data menggunakan mouse, ketika 
klik [Modify Value] maka perubahan ON/
OFF pada bit device dan word device 
bisa dilakukan. (Merujuk pada halaman 
berikutnya).

2) Pilih [Online] → [Monitor] → [Device/Buffer 
Memory Batch] di menu atau klik kanan 
ladder window dan pilih [Device/Buffer 
Memory Batch].

Catatan
3) masukkan nomor device 

5) Modify Value
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3.7.4 Test Device

[1] Forcing ON/OFF
Meng-ON/OFF-kan secara paksa bit device (M, Y, T, C, dll) pada PLC.  Pada saat PLC 
dalam keadaan RUN, ketika input (X) yang sedang dalam kondisi forcing ON/OFF maka 
pengoperasian ON/OFF hanya pada satu periode kalkulasi. Setiap pelaksanaan konfirmasi 
pengoperasian output (Y), buat PLC dalam kondisi STOP. 

1)	Kondisikan pada monitor rangkaian 
(Merujuk pada [Rangkaian Monitor] 
sebelumnya). 

2)	Dari Menu pilih [Debug] →[Modify Value]. 

Memaksakan ON/OFF (Window Rangkaian Monitor)
Sambil menekan [Shift] pada [Circuit Monitor Window], dobel klik pada bit device apapun 
(contact,coil), maka device yang dipilih akan dapat di-forcing ON/OFF. 

Referensi

3) Input nomor device yang di-forcing ON/
OFF. 

4) [Forcing ON] : Meng-ON-kan device.

    [Forcing OFF] : Meng-OFF-kan device.

    [Reverse Force ON/OFF] : Tiap ditekan      

    maka ON/OFF pada device akan muncul 
    bergantian. 

3) Masukkan device

4) Klik
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[2] Mengganti current value pada word device
Merubah current value pada word device PLC's (T, C, D, dll) ke value yang ditentukan.

1)	Kondisikan pada monitor rangkaian 
(Merujuk pada [Rangkaian Monitor] 
sebelumnya). 

2)	 Dari Menu pilih [Debug] → [Modify Value]. 

3) Input nomor device yang akan diubah, 
tekan tombol Enter. 

4) Input value yang diubah.

5) Klik [Set].

 

3) Masukkan device

4) Masukkan value baru 5) Klik
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[3] Forcing ON/OFF dan Merubah Current Value Menggunakan Watch 
Window 
Meng-ON/OFF kan bit device (M, Y, dll) secara paksa dari watch window, dan mengganti 
current value pada word device (T, C, D, dll). Pada saat PLC dalam keadaan RUN, ketika input 
(X) yang sedang dalam kondisi forcing ON/OFF maka pengoperasian ON/OFF hanya pada 
satu periode kalkulasi. Setiap pelaksanaan konfirmasi pengoperasian output (Y), buat PLC 
dalam kondisi STOP.

1)	Input nomor device pada kolom “Device/
Label”, registrasikan pada watch window.

 (Perhatian) Setelah registrasi, dari Menu pilih  
                    [Online]→ [Watch] →[Start watch].

2) Input perubahan value pada kolom “Current 
Value” tekan Enter .

•	Bit Device (X, Y, dll): 

   Input “1” untuk ON, “0” untuk  OFF.

•	Word Device (T, C, D, dll): 

   Input  jumlah  value  pada  range  yang 
dapat digunakan device.

2) Masukkan value baru

1) Register device.
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3.7.5 Writing saat Program sedang RUN
Ketika PLC sedang RUN, hanya bagian rangkaian yang telah dikoreksi yang dapat di-writing 
pada PLC. Agar keseluruhan program tidak tertransfer, lakukan writing program jangka 
pendek.

1)   Menjelaskan contact pada bagian 
kiri rangkaian dengan contoh yang 
ditambahkan.

Apabila tidak ada kesamaan antara program dalam PLC sebelum dikoreksi dengan program 
dalam PC maka writing tidak dapat dilaksanakan. Silahkan konfirmasi dahulu mengenai kesamaan 
program dan kejelasannya, atau silahkan transfer kolektif dengan [Write to PLC].

Perhatian

2) Tambahkan  contact. Blok rangkaian 
ditampilkan dengan warna abu-abu. 

3) Tekan [Shift] dan [F4] bersamaan atau pilih 
[Compile] → [Online Program Change]   
dari menu.

5) Klik [OK] pada tampilan message [Online 
change has completed]. 

Tulis saat RUN [Shift]+[F4]

4) Klik [Yes] pada warning message yang 
berisi peringatan mengenai ada atau 
tidaknya masalah keamanan pada 
perubahan control PLC yang disebabkan 
oleh perubahan program. 

2) Tambahkan contact

4) Klik

5) Klik
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3.8 Input  Comment 
3.8.1 Tipe Comment
Berikut adalah tiga tipe comment yang bisa diinputkan.

Tipe Tujuan Jumlah karakter Keterangan

1) Device comment
Comment yang menunjukkan 
peran dan kegunaan tiap 
device.

16

Untuk menulis pada PLC diperlukan "Comment 
Capacity Setting" pada parameter. Kemudian 
juga diperlukan (Comment Range Setting) pada 
penulisan.

2) Statement
Comment yang menunjukkan 
peran dan kegunaan rangkaian 
blok.

32
Comment hanya untuk bagian software pada PC 
(tidak termasuk dalam PLC).

3) Note
Comment yang menunjukkan 
peran dan kegunaan instruksi 
output.

16
Comment hanya untuk bagian software pada PC 
(tidak termasuk dalam PLC).

[Contoh Comment]

Global Device Comment dan Local Device Comment pada GX Works2
•	 [Global Device Comment]: Comment yang dapat me-writing pada PLC. 
•	 [Local Device Comment] :Dengan menyeting baru local device comment, global device comment 

dapat membuat comment yang berbeda berkali-kali. Kemudian dengan Developer, pada nama 
comment program yang berbeda dapat digunakan QnH, QnU, dll, tetapi tidak dapat dilakukan 
writing pada PLC. dengan FX series.      

•	 Umumnya pilih [Global Device Comment].

Poin

Cara Menampilkan Comment
Dari Menu pilih [View] → [Comment] dan comment akan ditampilkan.
Untuk menghentikan tampilan comment, lakukan kembali pengoperasian di atas.

Poin

Pada T5 N.O. contact ada pada 
step 10, N.C. contact ada pada  
step 8.

2) Statement

3) Note

1) Comment
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3.8.2 Operasi Pembuatan Device Comment 

[1] Input  Method dari Daftar
1) Pada daftar project klik [Global Device 

Comment]. 

2)Input nomor awal dari device yang akan 
membuat comment pada [Device name], 
lalu tekan Enter .

3) Input Comment pada kolom [Comment].

•	Untuk meng-input comment pada device 
yang lain input-kan lagi nomor device 
dengan cara 2.

1) Klik   dari toolbar dan dobel klik pada 
simbol diagram rangkaian yang akan 
diinput comment.

2) Input comment pada window [Input 
Comment], kemudian klik [OK]. 

    Jika pengoperasian selesai, klik sekali lagi 
pada .

[2] Input  Method dari Diagram Rangkaian

1) Double-klik

1) Dobel-klik

2) Masukkan comment

2) Masukkan nomor device

3) masukkan comment 
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      Setting untuk Writing Device Comment pada PLC
Untuk writing comment pada PLC, diperlukan “Parameter Setting‟ dan Range comment Setting”.

1) Setting untuk paramater

Poin

1)	 Pilih [Parameter] → [PLC 
Parameter]. 

2)	Setting “Jumlah blok” pada 
settingan [Comment Capacity].
Sekitar 1 blok setara dengan 50 
poin comment, dan memakan 
kapasitas program 500 step 
bagian.

Settingan input comment pada saat pembuatan jaringan 
Referensi

Ketika input rangkaian, klik icon disamping 
kanan dan ubah. 

2) Setting kapasitas comment

Kapasitas program 
berkurang seiring 
dengan blok komen yang 
ditambahkan.

 2) Cek  3) Klik

4) Setting 
jangkauan 
comment

2) Setting untuk jangkauan comment

1)	Pilih [Online] →[Write to PLC] 
dari menu. 

2)	Tandai "global device comment". 

3)	Klik [details]. 

4)	Pada dialog setting detail device 
comment, Setting tipe dan range 
pada device yang di-writing pada 
PLC. 

1) Dobel klik
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3.8.3 Operasi Pembuatan Statement

1) Klik  dari toolbar, dan dobel klik bagian 
apapun pada blok rangkaian yang akan 
diinput statement.

2) Input statement pada window [Enter Line 
Statement] lalu klik [OK].

    Setelah pengoperasian selesai, klik sekali 
lagi  pada toolbar.

3.8.4 Operasi Pembuatan Note

1) Klik  dari  toolbar,  dobel  klik  pada 
Output instruction symbol yang akan 
diinput note.

2) Input note pada window [Enter Note], lalu 
klik [OK].

    Setelah pengoperasian selesai, klik sekali 
lagi  pada toolbar.

1) Dobel Klik

1) Dobel klik

2) Input Note

2) Input statement



Instruksi Itu Tidak Sulit!

Sampai Bab ini.....
Telah disebutkan bahwa PLC yang merupakan kumpulan relay, timer, counter 
dalam jumlah  besar,  dan  sequence  di  dalam  bagiannya  tersebut  di-  wiring  
dengan  operasi penggunaan  peralatan  programming  peripheral.  Pada  
pekerjaan  wiring  ini,  cara menghubungkan contact dan coil, peraturan yang 
diperlukan berdasar pada tipe coil, inilah yang disebut instruksi.

Pada format instruksi, terdapat instruction language + device, atau fungsi pada 
independent 4 instruction language.

Pada  bab  ini  ada  beberapa  instruksi  dasar  yang akan  diperkenalkan  untuk  
menjalankan program pada PLC.

Mari mengingat arti masing-masing instruksi tersebut.

INSTRUKSI SEQUENCE 
BAB 4 



74

4.1 Mari Mengingat Instruksi 
4.1.1 Instruksi dan Program
Pada peripheral (Alat Programming ) yang digunakan untuk menginput program 
sequence, terdapat gambaran rangkaian sequence pada layar, dan penginputan 
program (List Program) dengan instruction language program. Walaupun input 
method program ini berbeda, programnya sendiri masih sama. 

Di bawah ini menampilkan perintah yang dimiliki PLC dan diagram rangkaian 
yang mengartikan masing-masing perintah tersebut.

     dan     yang digunakan 
pada tampilan rangkaian 
menunjukkan contact, 
berdasarkan ON/OFF dari 
input relay dan output relay , 
auxiliary relay, timer, counter 
menjadikan kondisi konduksi 
dan kondisi non konduksi.

          dan    SET        
menunjukkan drive coil.
 

Alat yang digunakan untuk input
menggunakan instruksi kata.

Alat yang digunakan untuk input
menggunakan diagram ladder.

LD

LDI

AND

ANI

OR

ORI

ANB

ORB

OUT

SET

RST

NOP

END

Simbol, Sebutan

Load

Load inverse

AND

AND inverse

OR

OR inverse

AND block

OR block

Out

Set

Reset

No operation

END

Instruksi 
koneksi bus
N.O. contact

Instruksi 
koneksi bus
N.C. contact

koneksi seri,
N.O. contact

koneksi seri,
N.C. contact

Koneksi pararel, 
N.O. contact

Koneksi pararel, 
N.C. contact

Koneksi seri
antar blok

Koneksi seri
antar blok

Instruksi
Coil drive

Operasi Latch ,
Instruksi coil

Batal operasi latch
operation, instruksi

coil

Tidak ada operasi

Mengakhiri 
program

Mengakhiri program Mengembalikan ke step 0

Untuk menghapus program atau spasi

Fungsi Lambang Ladder

SET YMS

RST YMSTCD



75

Pada program, instruction language dan device (operand) sebagian besar terkumpul dan terstruktur. 
Pada instruksi tersebut terpasang angka sesuai urutan, ini disebut dengan nomor step (Nomor step 
teratur secara otomatis). 

”Instruction”, terstuktur oleh ”Language Instruction + device”. Tetapi, pada language instruction ada 
juga instruksi yang tidak sesuai dengan device. Kemudian, ada juga language instruction yang 
direpresentasikan dengan instruksi saja.

Step number program dapat dibuat sampai range “kapasitas memori program” yang dimiliki oleh 
PLC yang digunakan. Ini disebut dengan PLC program capacity. Misal PLC FX1S dengan “2000”
 step, PLC FX3G dengan “32000” step, dan PLC FX3U diinternalkan dengan memori program 
“64000” step. 

Instruksi dijalankan berulang kali dari 0 step sampai Instruksi END. Ini disebut dengan cyclic operation, 
dan waktu yang diperlukan dalam sekali putaran disebut dengan periode kalkulasi (scan time). Siklus 
kalkulasi berubah berdasarkan isi program dan urutan proses sesungguhnya, tetapi nilainya setingkat 
ms angka normal～ms puluhan.

Pada PLC program yang telah dibuat dengan format diagram rangkaian (diagram ladder) maupun 
memori program internal PLC disimpan dengan format “Instruction list (program list)”. Pada software 
programming yang menggunakan PC, “Instruction list ( Program list)”, dan diagram rangkaian (diagram 
ladder) diubah secara bersamaan.

 

 

 

 

 Diagram rangkaian (Diagram Ladder)

Nomor
Step

Instruksi

0
1
2
3
4
5
6
9

LD
OR
ANI
OUT
LD
ANI
OUT
END

X001
Y000
X003
Y000
Y000
X006

T1  K30

Daftar Instruksi (Daftar Program)

O
pe

ra
si

 b
er

ul
an

g

4.1.2 Mekanisme Program

X001
Y000

Y000

X003
0

4

END

X006
T1

K30

9

Y000

Internal sequence yang digunakan untuk menjalankan kendali sequence, dibuat sebagai program 
sequence dan juga sebagai Instruction list (Program list) serta diagram rangkaian (diagram ladder).

Bahasa
Instruksi

Nomor alat
(Device)
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OUT
END

Daftar Program

Program ladder

Output Y000 menjadi ON ketika input X000 ON.
Output Y003 menjadi ON ketika input X003 OFF.

Pada generating line, LD instruction (load) 
digunakan pada N.O. contact yang 
pertama kali digunakan, kemudian LDI 
instruction (load inverse) digunakan pada 
N.C. contact. Contact untuk instruksi D, 
LDI, dan lainnya digunakan untuk device 
input relay X, output relay Y, timer T, 
counter C, auxiliary relay M, dan lain-lain. 
Coil drive instruction pada OUT dan 
lainnya digunakan untuk device selain 
input relay X.

Pada program di atas
Input  X000

Output  Y000

Output  Y003

0
Step Instruction

LD X000
OUT Y000
LDI X000
OUT Y003
END

1
2
3
4

LD
LDI

Koneksi bus
Perintah untuk N.O. contact 

Load

Koneksi bus
Perintah untuk N.C. contact 

Load inverse

Perintah untuk
Coil drive 

Out

Perintah untuk mengakhiri 
pemrograman

End

Step numbers
Menampilkan urutan dan ukuran 
program. Apabila anda memprogram 
sebuah instruksi pada sebuah urutan 
dari daftar program, PLC secara 
otomatis akan menetapkan step 
numbers.

4.1.3 N.O. Contact, N.C. Contact, Instruksi OUT, Instruksi END

X000

Jalur ini disebut “bus”.

0

X000
2

4

Y000

Y003

END

Pemrograman Berdasarkan Daftar Instruksi

ONOFF OFF

ONOFF OFF

ON OFF ON

Referensi
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Daftar Program

Program Rangkaian

Output Y000 menjadi ON ketika input X000 ON, 
X001 ON, dan X002 OFF.
Output Y003 menjadi ON ketika input X000 ON, 
X001 ON, X002 OFF, dan X003 ON.

Y000 dan Y003 beroperasi 
apabila contact serial yang 
menggerakkan ini terkonduksi 
seluruhnya.

Menggunakan instruksi AND (and) pada N.O. 
contact yang telah terkoneksi dengan serial 
setelah LD dan LDI, dan menggunakan 
instruksi ANI (and inverse) pada N.C. contact. 

Input  X000

Pada program di atas...

Input  X002

Input  X001

Input  X003

Output  Y000

Output  Y003

0
Step Instruksi

LD X000
AND X001
ANI X002
OUT Y000

X003AND
Y003OUT

END

1
2
3
4
5
6

AND
ANI

Koneksi seri 
perintah untuk
N.O. contacts

AND

Koneksi seri 
Perintah untuk
N.C. contacts

AND inverse

Pemrograman berdasarkan daftar instruksi 

X000
0

6 END

X001
Y000

Y003

X002

X003

ON

ON

ON

ONOFF

ON

ON

ON

4.1.4  Koneksi seri

Referensi
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OR
ORI

Daftar Program

Menggunakan instruksi OR (or) pada N.O. 
contact yang telah terkoneksi dengan paralel 
pada LD dan LDI, dan menggunakan instruksi 
ORI (or inverse) pada N.C. contact.

Output Y000 diatas akan beroperasi apabila 
salah satu dari contact paralel yang digerakkan.

Pada program di atas...

0
Step Instruksi

LD X000
OR X001
ORI X002
OUT Y000
END

1
2
3
4

Koneksi pararel
Perintah untuk 
N.O. contacts

OR

Koneksi pararel
Perintah untuk 
N.C. contacts

OR inverse

Program rangkaian

Pemrograman berdasarkan daftar instruksi

4.1.5  Koneksi Pararel

X000
0

2

4 END

Y000

X001

X002

ON

ON

ON

ON OFF

ON

Input  X000

Input  X002

Input  X001

Output  Y000

.
Referensi
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Daftar program

Program rangkaian
Contoh program 1

Contoh program 1

Contoh program 2

Ketika input X000 atau X001, dan 
X002 atau X003 menyala secara 
simultan, Y000 akan menyala. 

Ketika input X000 dan X001 menyala 
secara simultan atau X002 dan X003 
menyala secara simultan, output Y000 
akan menyala. 

Untuk detail instruksi ANB dan ORB 
merujuk pada lampiran.

Pada program di atas... Pada program di atas...

Input  X003

Input  X002

Input  X001

Input  X000

Output  Y000

Input  X003

Input  X002

Input  X001

Input  X000

Output  Y000

0
Step Instruksi

LD X000
OR X001
LD X002
OR X003

Y000
ANB

1
2
3
4

OUT
END

5
6

4.1.6 Koneksi seri dan pararel

Pemrograman berdasarkan daftar instruksi

X000
0

END

Y000
X002

X001 X003

X000
0

END

Y000
X001

X002 X003

ON

ON

ON

ON

ONON

ON

ON

ON

ON

ONON

Daftar program
Contoh program 2

0
Step Instruksi

LD X000
AND X001
LD X002
AND X003

Y000
ORB

1
2
3
4

OUT
END

5
6

Referensi
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SET
RST

Program rangkaian

Ketika meng-ON-kan input X001, 
output Y000 menjadi ON. Setelah itu, 
walapun input X001 di OFF-kan dari 
ON, operasi Y000 tetap tersimpan 
dalam posisi ON. Ketika meng-ON-kan 
input X003, output Y000 menjadi OFF.

Instruksi yang menggerakkan coil sama 
dengan instruksi OUT.Pada instruksi OUT, 
apabila contact yang menggerakkan coil 
berubah dari ON menjadi OFF, maka coil 
yang dioperasikan oleh instruksi OUT juga 
menjadi OFF, namun apabila menggunakan 
instruksi SET (set), walaupun contact 
berubah dari ON menjadi OFF, coil akan 
tetap tersimpan dalam kondisi 
pengoperasian ON. Untuk membuat coil 
yang digerakkan dengan instruksi SET (set) 
berubah dari ON menjadi OFF, gunakan 
instruksi RST (reset).

Pada program di atas

Daftar Program

0
Step Instruksi

LD X001
SET Y000
LD X003
RST Y000
END

1
2
3
4

Instruksi SET/RST digunakan 
pada output relay Y, auxiliary relay 
M, dll.Selain itu, instruksi RST 
juga digunakan untuk counter dan 
accumulated timer.

Operasi hold
Perintah output

Set

Operasi hold
Membatalkan perintah

Reset

4.1.7 Instruksi SET , Instruksi RST

X001
0

X003
2

4 END

Y000RST

Y000SET

Pemrograman berdasarkan instruksi

ON

ON

ON
Cara Input

Space

Space

Input X001

Input X003

Output Y000

Referensi
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4.1.8 Tentang Rangkaian Self Holding
Output pengoperasian bisa ditahan atau dilepas berdasarkan 
susunan program sekuensnya.

0
1
2
3
4

Step
LD
OR
ANI
OUT
END

X001
Y003
X003
Y003

Instruksi
0
1
2
3
4

Step
LD
SET
LD
RST
END

X001
Y003
X003
Y003

Instruksi

Saat X001 ON, dan X003 OFF, 
maka Y003 menjadi ON.

Walaupun X001 diubah menjadi 
OFF, Y003 melanjutkan 
pengoperasiannya (self holding
operating),  tetapi  ketika  X003  
di-ON-kan maka akan menjadi 
OFF.

Ketika menggunakan instruksi SET, walaupun contact yang menggerakkan coil menjadi kondisi OFF, output tetap 
disimpan dalam keadaan ON. Kemudian seberapa kali pun program bekerja pada output (Y), dan dibandingkan 
dengan program pada OUT coil, tidak akan diperlakukan menjadi double coil. Membandingkan dengan rangkaian self 
holding, saat ingin mengontrol ON/OFF secara langsung dari berbagai tempat program pun menggunakan output 
device yang sama.

Pada program di atas...

Program rangkaian

[Daftar self-holding output]  [Daftar SET/RST output] 

[Daftar self-holding output]  [Daftar SET/RST output] 

Input  X001

Output  Y003

Input  X003

X001
0 Y003

Y003

X003

ON

ON

ON

X001
Y003

Y003

X003

END

X001

X003

END

Y003SET

Y003RST
operasi yang 

sama

0

4

0

4

2

Pemrograman berdasarkan daftar instruksi

Keduanya sama-sama rangkaian holding operasi outputReferensi

Referensi
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4.2  Tentang Rangkaian Timer 

0
1
2

Timer Referensi

Program timer

Ada beberapa hal pada timer, di sini akan 
dijelaskan cara kerja program micro-PLC 
yang memiliki jam digital.

Step
LD
OUT
OUT

X000
Y000
T0 K100

Instruksi
5
6
7

Step
LD
OUT
END

T0
Y003

Instruksi

Timer contact hanya melambatkan waktu 
yang ditentukan setelah aliran coil (on 
delay time). Waktu yang ditentukan ini 
disebut dengan setting value, ditampilkan 
dengan K. Nilai setting value K dapat 
diatur dari nilai 1 ～ 32,767.

Contoh, saat K100, timer menjadi 10 
detik.*1

 *1: Waktu penggunaan timer dasar 100ms (0.1 detik)

Pada program di atas...
Input  X000

Output  T0 (N.O. contact)

Output  Y000, T0 (coil)

Output  Y003 (coil)

X000
0

5

Y000

T0
(10 secs)

Y003

END7

K100

T0

ON

ON

ON

ON

10 secs

SECONDS

10

30

4020

50

600

STAR DELTA TIMER

Pemrograman berdasarkan daftar instruksi

Program rangkaian

Space

Dalam timer driving, ketika 
meng-OFF-kan X000, current value timer 
kembali menjadi 0, dan timer contact pun 
menjadi OFF.

Cara input

Referensi
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4.3 Tentang Rangkaian Counter 

Counter

Program Counter

Ada beberapa hal pada counter, di sini akan 
dijelaskan cara kerja program counter untuk 
umum dari micro-PLC.

0
1
3
4

LD
RST
LD
OUT

X001
C0

C0
X003

7
8

LD
OUT

9

C0
Y003

Counter  menghitung  frekuensi  perubahan
contact (X003) dari OFF → ON. Hal tentang 
contact (X003) ini disebut counting input, 
angka yang terhitung berdasarkan counter 
disebut current value.

Lalu, counter contact akan beroperasi ketika 
current value mencapai angka yang 
ditentukan (setting value) . Pada setting 
value, dapat diatur nilai dari 1 ～ 32,767.

Setelah counter up, output contact pun 
masih beroperasi tanpa  merubah  current  
value counter. 

Ketika meng-ON-kan reset input X001, 
current value counter menjadi 0, dan 
counter contact pun menjadi OFF.

Cara input

Output Y003

Present value of 
counter C0

Input X003 (count)

Input X001 
(reset)

ON

0
1

2
3

4
5

6
7

8
9 10

Lampiran

Step Instruksi Step Instruksi

Pemrograman berdasarkan daftar instruksi

TIME

Pada Program di atas...

X001
0

7

C0
K10

Y003

END9

C0RST

X003

C0

3

Reset input

Count input

K10
END

Space

Referensi
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Menjalankan program sesuai urutan dari (1) to (16) seperti di atas.

4.4 Urutan Program 
Urutan program adalah 
Program pada diagram rangkaian berjalan berurutan dari kiri ke kanan dan dari 
atas ke bawah. 

0
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

LD
Step Instruksi

OUT
LD
OR
AND
OUT
OUT
LD
AND
LD
AND
ORB
OUT
OUT
OUT
END

X000
Y000
X001
X002
X003
Y001
Y002
X004
X005
X006
X007

Y003
Y004
Y005

(1)

(3)

(4)

(5)

(2)

(6)

(7)

(13)

(14)

(15)

(16)

X000

X001

Y000

Y001

X002

X003

Y002

X004 X005
Y003

X006 X007

Y005

END

Y004

0
Step

2

7

15

(8) (9)

(10) (11) (12)

Pemrograman berdasarkan daftar instruksi 
Referensi



Dari Program yang mudah 

Teori secara sederhana
Pada bab ini akan mempelajari keseluruhan pengoperasian yang ditangani, 
seperti program, monitor, dan lain-lain berdasarkan contoh yang mudah. 

Latihan Program 
BAB 5
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Lintasan
eskalator 
Y003

Saklar pendeteksi 
pengguna: 1 

X003

Lampu 
Penerang 
Y000

Saklar pendeteksi 
pengguna: 0

X001

5.1 Contoh Pengenalan 1 
      (Kontrol Eskalator)

  I/O Penandaan
Input  Deteksi pengguna switch: 0  X001
  Deteksi pengguna switch: 1  X003

Output Lampu penerang Y000
  Lintasan eskalator Y003

  Operasi
(1)Eskalator dibuat tidak bergerak sampai ada orang mendekati eskalator. 
(2)Apabila orang mendekati eskalator maka passage detection switch: 0 menjadi 

ON, lampu penerang akan menyala dan eskalator bergerak. (hanya untuk 
eskalator naik).

(3)Apabila orang diangkut ke atas dan diturunkan oleh eskalator, maka passage 
detection switch: 1 akan menjadi ON, dan lampu penerang maupun eskalator 
sama-sama kembali ke kondisi tidak beroperasi.

Sampai di sini,mari kita pikirkan passage detection switch 0 dan 1 
bersama-sama sebagai non-holding tipe switch. Kemudian, pengguna eskalator 
dibuat untuk tidak menaiki terus menerus. 

Mari kita pikirkan tentang program PLC dengan eskalator sebagai contohnya.
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Lintasan
eskalator 
Y003

Saklar pendeteksi 
pengguna: 1 

X003

Lampu 
Penerang 
Y000

Saklar pendeteksi 
pengguna: 0

X001

5.1 Contoh Pengenalan 1 
      (Kontrol Eskalator)

  I/O Penandaan
Input  Deteksi pengguna switch: 0  X001
  Deteksi pengguna switch: 1  X003

Output Lampu penerang Y000
  Lintasan eskalator Y003

  Operasi
(1)Eskalator dibuat tidak bergerak sampai ada orang mendekati eskalator. 
(2)Apabila orang mendekati eskalator maka passage detection switch: 0 menjadi 

ON, lampu penerang akan menyala dan eskalator bergerak. (hanya untuk 
eskalator naik).

(3)Apabila orang diangkut ke atas dan diturunkan oleh eskalator, maka passage 
detection switch: 1 akan menjadi ON, dan lampu penerang maupun eskalator 
sama-sama kembali ke kondisi tidak beroperasi.

Sampai di sini,mari kita pikirkan passage detection switch 0 dan 1 
bersama-sama sebagai non-holding tipe switch. Kemudian, pengguna eskalator 
dibuat untuk tidak menaiki terus menerus. 

Mari kita pikirkan tentang program PLC dengan eskalator sebagai contohnya.

Program menjadi seperti berikut ini.
  Rangkaian program : Contoh 1

Rangkaian program : Contoh 2

Mari kita pastikan pengoperasiannya
Mari kita input program diatas ke PLC, dan memastikan kembali 
pengoperasiannya. 

Ketika meng-ON-kan input X001, maka output Y000 dan Y003 akan beroperasi. 
Selanjutnya, ketika meng-ON-kan input X003, maka output Y000 dan Y003 
menjadi tidak beroperasi.

Saklar deteksi
penumpang: 0
      X001

 Saklar deteksi
penumpang: 1

X003 Lampu penerang ON

Lintasan Eskalator

Self hold 
   Y000

Y000

Y003

END

Saklar deteksi
penumpang: 0
      X001

 Saklar deteksi
penumpang: 1

X003

Lampu penerang ON

Lintasan Eskalator

Lampu penerang OFF

Eskalator berhenti

END

Y000SET

Y003SET

Y000RST

Y003RST

0

5

0

3

6

Daftar program merujuk pada lampiran 2
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5.2 Contoh pengenalan 2 (Kontrol Mesin Penyedia Teh)

Mari kita pikirkan tentang program PLC dengan alat penyedia teh sebagai contohnya. 

  I/O penandaan 
Input Pendeteksi cangkir X000 (ON ketika cangkir ada)
 Tombol penyedia teh X001
 Tombol konfirmasi daun teh X002
 Saklar batas minimal tanki pengisi air X003
 Saklar batas maksimal tanki pengisi air X004

Output Lampu indikator pengganti daun teh Y000
 Output penyedia teh Y001
 Output pengisi air Y003

  Penjelasan operasi
(1)Apabila deteksi cangkir X000 ON, dan ketika kita menekan tombol penyedia teh X001, 

maka output penyedia teh Y004 akan beroperasi, dan air panas tertuang ke cangkir. 
     Air panas akan tertuang hanya saat cangkir sudah berada di tempatnya.

(2)Apabila air di tabung berkurang, batas minimal LS X003 akan menjadi ON, dan output 
penyedia air Y003 akan beroperasi. tombol ditekan, dan ketika tombol dilepaskan 
maka air panas akan berhenti. Saat deteksi cangkir X000 OFF, air panas tidak akan 
tertuang walaupun tombol penyedia teh X001 ditekan. Apabila output penyedia air 
Y003 beroperasi dan air tertuang ke tabung, tidak lama kemudian batas maksimal LS 
X004 menjadi ON, dan output penyedia air Y003 menjadi tidak beroperasi.

(3)Apabila pengoperasian penyedia air telah dilaksanakan sebanyak 5 kali, lampu tanda 
pengganti daun teh akan menyala. tidak beroperasi. 

(4)Apabila menekan tombol konfirmasi, lampu tanda pengganti daun teh akan mati. 

Pengganti daun teh

Output penyedia air

Saklar batas maksimal

Saklar batas minimal

Y003

Y000

Dispense
Check

Konfirmasi
penggapai daun teh

X002

X003

Pendeteksi cangkir
X000

X004Tombol penyedia teh
X001

Output penyedia teh
Y001

Program menjadi seperti berikut ini
  Rangkaian program

Mari kita periksa pengoperasiannya 
Mari kita input program diatas ke PLC, dan memastikan kembali 
pengoperasiannya. 
(1)Apabila input X000 dan X001 sama-sama ON, maka output Y001 akan 

beroperasi. 
(2)Apabila input X003 ON, maka output Y003 akan beroperasi, lalu apabila 

input X004 ON, maka output Y003 menjadi tidak beroperasi. 
(3)Setiap output Y003 beroperasi, nilai counter C0 bertambah satu persatu, 

dan nilai menjadi 5, maka Y000 akan beroperasi. 
(4)Apabila input X002 menjadi ON, maka nilai counter C0 akan menjadi 0 dan 

output Y000 menjadi tidak beroperasi. 

X000 X001

X003 X004

Y003

X002

Y000

RST C0

C0

Y001

END

C0

Y003
K5

Y003

Self holding

Saklar batas minimal Saklar batas maksimal

Tombol penyedia teh
Output penyedia teh

Output pengisi air

Frekuensi isi ulang air

Lampu indikator pengganti daun teh

Reset Penghitung

Pendeteksi cangkir

Output pengisi air

Tombol konfirmasi
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Program menjadi seperti berikut ini
  Rangkaian program

Mari kita periksa pengoperasiannya 
Mari kita input program diatas ke PLC, dan memastikan kembali 
pengoperasiannya. 
(1)Apabila input X000 dan X001 sama-sama ON, maka output Y001 akan 

beroperasi. 
(2)Apabila input X003 ON, maka output Y003 akan beroperasi, lalu apabila 

input X004 ON, maka output Y003 menjadi tidak beroperasi. 
(3)Setiap output Y003 beroperasi, nilai counter C0 bertambah satu persatu, 

dan nilai menjadi 5, maka Y000 akan beroperasi. 
(4)Apabila input X002 menjadi ON, maka nilai counter C0 akan menjadi 0 dan 

output Y000 menjadi tidak beroperasi. 

X000 X001

X003 X004

Y003

X002

Y000

RST C0

C0

Y001

END

C0

Y003
K5

Y003

Self holding

Saklar batas minimal Saklar batas maksimal

Tombol penyedia teh
Output penyedia teh

Output pengisi air

Frekuensi isi ulang air

Lampu indikator pengganti daun teh

Reset Penghitung

Pendeteksi cangkir

Output pengisi air

Tombol konfirmasi

Daftar program merujuk pada lampiran 2
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5.3 Contoh Pengenalan 3 (Kontrol Blower)

Mari kita pikirkan tentang program PLC dengan control blower sebagai contohnya. 

Operasi 
(1) Dengan meng-ON-kan switch persiapan operasi (X001), buat lampu siap beroperasi 

(Y000) ON, dan buat menjadi self- holding. Lalu, dengan meng-ON-kan switch 
pembatalan operasi (X003), buat lampu siap beroperasi (Y000) menjadi OFF, dan 
batalkan self-holding. 

(2) Apabila lampu siap beroperasi (Y000) dalam kondisi ON, lalu dengan meng-ON/OFF-
kan switch blower start/stop (X000), maka blower MC (Y002) dapat meng-start stop-kan 
operasi dari blower. Kecepatan blower dipilih dengan change-over switch (X005/X006). 
•	 Ketika X005 ON: Angin lemah (Y001)ON.
•	 Ketika X006 ON: Angin kuat (Y003) ON.

I/O penandaan
Input

X000 [Blower mulai/berhenti] saklar
X001 [Persiapan] saklar
X003 [Pembatalan persiapan] saklar
X005 [Angin lemah] pilihan
X006 [Angin kuat] pilihan

Output
Y000 [Lampu indikator kesiapan]
Y001 Output angin lemah

Y002
Kontaktor elektromagnetik untuk 
blower

Y003 Output angin kuat

Lampu indikator kesiapan Angin lemah Angin kuat
Y000

Persiapan
X001

Blower mulai/berhenti
X000

Pembatalan persiapan
X003

X005 X006 Blower

Kontaktor elektromagnetik
untuk blower

Y002

Output angin lemah
Y001

Output angin kuat
Y003
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Rangkaian program
Input device penting dalam ruang kosong dan selesaikan program ini. 

Y000

Y002 Y003

Interlock

Y001

Y001

Y0000

4

16 END

Y002

Y003

•	Untuk jawaban program, silahkan merujuk halaman akhir bab ini. 
•	Untuk list program, silahkan merujuk pada lampiran.               
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5.4 Contoh Pengenalan 4 (Kontrol mesin press)

Mari kita pikirkan tentang program PLC dengan kontrol mesin press sebagai contohnya. 

Operasi
(1) Dengan meng-ON-kan switch pengangkut barang (X001), dapat meng-ON-kan 

conveyor pengangkutan barang (Y003), dan mengangkut barang sampai keposisi press. 
Saat barang terdeteksi sebanyak 4 buah oleh sensor deteksi jumlah press (X004), maka 
conveyor pengangkutan barang (Y003) akan menjadi OFF dan berhenti. 

(2) Setelah conveyor berhenti, press start buzzer (Y001) akan berdering selama 1 detik, 
dan setelah itu press (Y002) bergerak. 

(3) Press (Y002) selesai dalam 2 detik, dan secara bersamaan buzzer (Y001) menjadi OFF.
(4) Setelah press selesai, jumlah press akan di-reset, dan proses akan dimulai kembali dari 

step 1.

I/O penandaan
Input

X001 Saklar ban berjalan
X004 Sensor penghitung barang

Output
Y001 Buzzer mulai mesin press
Y002 Press output
Y003 Ban berjalan

Ban berjalan
Y003

Saklar Ban berjalan
X001

Sensor penghitung barang
X004

Press output Y002

Buzzer mulai alat press
Y001

Alur Proses

Run
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Rangkaian program
Input device penting dalam ruang kosong dan selesaikan program ini. 

X004

X001 C0

Y003

0

4

8

21

18

END

C0
Y001

T0

Y002

T1

K10

K20

C0RST

•	Untuk jawaban program, silahkan merujuk halaman akhir bab ini. 
•	Untuk list program, silahkan merujuk pada lampiran.               
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5.5 Contoh pengenalan 5 (Timing Chart)
Mari kita pikirkan tentang program PLC dengan timing chart dibawah ini sebagai contoh. 

Operasi
Ketika meng-ON kan start switch (X001), lampu (Y000) ON, dan pada saat bersamaan 
timer (T0) akan memulai pengukuran waktu. Setelah 2 detik timer (T0) berada pada 
kondisi time up, buzzer (Y001) ON, maka pada saat bersamaan timer (T1) akan memulai 
pengukuran waktu. Setelah itu pada saat bersamaan, ON-kan secara berurutan MC (Y002), 
motor (Y003), solenoid valve (Y004) dengan jarak waktu 2 detik, kemudian pada posisi ON 
solenoid valve (Y004) yang terakhir dalam 2 detik, OFF-kan seluruh output. 

I/O penandaan
Input

X001 Saklar mulai
Output

Y000 Lampu indikator
Y001 Buzzer
Y002 Kontaktor elektromagnetic
Y003 Motor
Y004 Katup solenoid

Saklar mulai

Selisih: 2 detik.

Selisih: 2 detik.

Selisih: 2 detik.

Selisih: 2 detik.

Selisih: 2 detik.

Lampu indikator

Buzzer

Kontaktor
Elektromagnetik

Motor

Katup solenid

X001

Y000

Y001

Y002

Y003

Y004
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  program  
Input device penting dalam ruang kosong dan selesaikan program ini. 

T0

X001 T4
0

7

12

22

27

17

END

Y000

K20

T1

T2

T3

T0

•	Untuk jawaban program, silahkan merujuk halaman akhir bab ini. 
•	Untuk list program, silahkan merujuk pada lampiran.               
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5.6 Jawaban dari contoh pengenalan

Contoh 
Pengenalan 3

X001

Y000

X003

X000

X005

X006

Contoh 
Pengenalan 4

Y003

C0 K4

T0

T1

Contoh 
Pengenalan 5

Y000

Y001

T1 K20

Y002

T2 K20

Y003

T3 K20

Y004

T4 K20
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Mari Kita Buat Program dengan Menggunakan PC

Lampiran 1
Pengoperasian GX Developer 
Jika menggunakan PC, sequence menjadi lebih mudah ....
Pembuatan dan pengeditan program sequence, dapat dilakukan dengan mudah dengan 
ilustrasi jika menggunakan PC sofware GX Developer. 
Jika sudah menguasai operasi dasar, selanjutnya hanyalah akan mengulanginya saja. 
Terdapat banyak software dengan fungsi yang mudah digunakan, tetapi marilah kita kuasai 
dahulu secara berurutan, dimulai dari operasi yang penting. 

Pada starting-up dan pengaturan pun dapat 
dilakukan dengan lancar ......
Debug terpasang pada program untuk memonitor kondisi pengoperasian PLC atau program 
pada layar PC, bisa dilaksanakan dengan cepat, pemastian dan pengaturan pada bagian 
yang tidak beroperasi sesuai dengan yang diinginkan. 

Membuat program menjadi mudah untuk dibaca.... 
Pada GX Developer terdapat "Comment input function" untuk memudahkan melihat program 
sequence. Apabila akan menginput comment, maka efisiensi pembuatan sequence dan 

debug pun meningkat. 
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Lampiran 1.1 Pengetahuan Dasar untuk Pengoperasian GX Developer

Lampiran 1.1.1 Struktur Layar pada GX Developer  

1)	 Title bar 
Tampilan nama project yang terbuka dan icon proses window. 

    1) Title bar

   6) Status bar

  2) Menu bar

   3) Toolbar

5) Layar editing

    4) Daftar data proyek

Untuk mengganti ukuran GX Developer dan keluar Memaksimalkan dan mengembalikan ukuran GX Developer

Keluar dari GX DeveloperMengecilkan GX DeveloperMenampilkan nama 
proyek dan lokasi file
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2)	 Menu bar

Ketika memilih Menu, maka drop down menu akan ditampilkan. 

3)	 Toolbar

* : View item dan arrangement berbeda tergantung keadaan masing-masing karena isi toolbar 
dapat dipindah dan dihilangkan. 

4)	 Project data list

Window pembuatan rangkaian, layar parameter setting, dan lain-lain ditampilkan pada tree view. 

Deskripsi 
tentang fungsi 
akan muncul 
saat mouse 
berhenti pada 
salah satu 
tombol.

Secara spesifik item akan 
ditampilkan dengan meng-klik 
mouse.

Fungsi yang lebih sering digunakan ditempatkan pada icon button. Fungsi tersebut bisa langsung 
dijalankan dibandingkan dengan pilihan pada menu bar.
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5)	 Layar editing

6)	 Status bar 
Kondisi operasi dan setting ditampilkan.

5) Layar editing

Status scroll lock

Instruksi dari posisi
kursor mouse

Tipe 
CPU

Lokasi CPU yang
terhubung

Status
caps lock

Status
num lock 

Menampilkan mode yang sedang di-input

Layar pembuatan rangkaian, layar monitor dan lain-lain ditampilkan berkali-kali pada 
format window. 
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Lampiran 1.1.2 Tentang "Project"

"Project" adalah kumpulan dari program, device comment, parameter, device memory.  Gabungan 
serangkaian data pada GX Developer disebut "Project" dan disimpan sebagai folder Windows®. 

●● Mengedit Multi Proyek

    Apabila mengedit lebih dari 2 project pada GX Developer, silahkan start up GX Developer 

    
berkali-kali. 

Project

Program

Comment

Parameter

Device Memory

Sesuai dengan folder Windows®.

Program sequence.

Comment untuk alat (device).

Setting parameter data untuk PLC.

Berisi value alat (device) yang sedang terhubung
atau yang telah diinput.
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Lampiran 1.2  Start Up GX Developer dan Pembuatan Baru pada Project 
Lampiran 1.2.1 Start Up GX Developer 

1)	 Pilih sesuai urutan dari tombol  Start  pada 
Windows®, kemudian, 

                   ↓ 
[MELSOFT Application] 
             ↓ 
[GX Developer]

2)	 GX Developer sudah bisa dimulai.
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1)	 Pilih   pada toolbar, atau dari Menu 
[Project] → [New project] ( Ctrl  + N ).

Lampiran 1.2.2 Pembuatan Project Baru 

2)	 Klik the [▼] button of [PLC series].
3)	 Pilih  "FXCPU".

4)	 Klik   [▼] tombol dari [PLC Tipe].
5)	 Pilih  "FX3U(C)".

Perhatian: Pilih tipe PC yang akan digunakan.

1) Klik

1) Klik

 3) Klik dan pilih

2) Klik

 5) Klik dan pilih

4) Klik
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6)	 Klik  OK .

7)	 Ditampilkan layar proyek yang baru, program 
menjadi dalam kondisi dapat diinput. 

6) Klik

7) Layar proyek baru
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Lampiran 1.3 Membuat program
Lampiran 1.3.1 Membuat program menggunakan fungsi key

[Program yang akan dibuat]

X002
Y000

Y000

X000

X003
Y001

•	 Tombol fungsi dan hubungan nomor rangkaian ditampilkan pada tombol toolbar.  
                                                                
                                                                          Key operasi utama 
 
 
 
 
 
 
 
 

•	 Pada saat pembuatan rangkaian, selalu gunakan "Writing Mode".  

Pilih dari toolbar 	 Dari Menu pilih( [Edit]  → [Write mode]). 
 
 
 
 
 
 
 
 
 
 
 
 
 

•	 Gunakan half width character untuk seluruh huruf yang akan diinput. 

Poin

F5 F6 F7

F8

F9

F5

Shift Shift

F6

Shift

F9

Ctrl

F10

F9

Ctrl
+

++++

Pada buku ini,  nomor input relay 
dan output relay ditampilkan sebagai 
"X000", "Y000" menggunakan tiga 
digit. "X0", "Y1" dan "0" pada sisi kiri 
depan dapat disingkat ketika input 
ditampilkan dari GX Developer.

Poin



106

1)	 Tekan tombol F5  . 
Input "X2".

6)	 Ditampilkan rangkaian yang telah diinput          .
7)	 Tekan F7  Input "Y0".
8)	 Konfirmasi dengan menekan Enter  lalu [OK].

9)	 Ditampilkan rangkaian yang telah diinput             .
10)	�Tekan Shift  + F5    Input "Y0".
11)	Konfirmasi dengan menekan Enter  lalu [OK].

3)	 Ditampilkan rangkaian yang telah diinput 
X2

.
4)	 Tekan tombol  F6   key. 

Input "X0".
5)	 Konfirmasi dengan menekan Enter  lalu [OK].

Batalkan dengan ESC  atau [Exit].

2)	 Konfirmasi dengan menekan Enter  lalu [OK].

1) Input "X2"   2) Input Enter

4) Input "X0"

3) Elemen ladder ditampilkan

  5) Tekan Enter

6) Elemen ladder ditampilkan

7) Input "Y0"   8) Tekan Enter

  11) Tekan Enter  10) Input "Y0"

9) Elemen ladder ditampilkan

X0
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12)	 Ditampilkan rangkaian yang telah diinput             .
13)	 Arahkan kursor pada permulaan garis  
       selanjutnya.
14)	 Tekan F5  . 

 Input "X3".
15)	 Konfirmasi dengan menekan Enter  lalu [OK].

16)	 Ditampilkan rangkaian yang telah diinput
X3

.
17)	 �Tekan F7  Input "Y1".
18)	 Konfirmasi dengan menekan Enter  lalu [OK].

19)	 �Ditampilkan rangkaian yang telah diinput            . 
 

12) Elemen ladder ditampilkan

13) Gerakkan kursor

  15) Tekan Enter 14) Input "X3"

17) Input "Y1"   18) Tekan  Enter  

16) Elemen ladder ditampilkan

19) Elemen ladder ditampilkan

F4  (Convert)

20) Bayangan abu-abu menghilang
20) Operasi Perubahan Rangkaian (Penting).
	 Jalankan operasi F4 (Conversion) untuk 

menetapkan diagram rangkaian yang belum 
	 ditetapkan (Bagian dengan warna abu-abu).
 

Tekan F4  (Convert) 
      atau pilih  pada toolbar, atau dari Menu 
      pilih  [Convert] → [Convert] dari menu.

Tampilan abu-abu menghilang dan program 
telah dikonfirmasi Apabila terjadi error, kursor 
akan bergerak otomatis ke bagian yang 
bermasalah dari program. Koreksi program.

Y0



108

Lampiran 1.3.2 Pembuatan Rangkaian Menggunakan Tool Button 

[Program yang akan dibuat]

•	 Klik mouse tool button , input simbol rangkaian. 
                                                                              Tombol-tombol pada toolbar utama

•	  

•	 Pada saat pembuatan rangkaian, selalu gunakan "Writing Mode". 

•	 Pilih dari menu [Edit] → [Write mode]). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

•	 Gunakan half width character untuk seluruh huruf yang akan diinput. 

•	 Tidak bisa menggunakan full width character. 

Poin

X002
Y000

Y000

X000

X003
Y001

Pada buku ini,  nomor input relay 
dan output relay ditampilkan sebagai 
"X000", "Y000" menggunakan tiga 
digit. "X0", "Y1" dan "0" pada sisi kiri 
depan dapat disingkat ketika input 
ditampilkan dari GX Developer.

Poin
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6)	 Ladder yang diinput ditampilkan         .
7)	 Tekan pada tombol tool  . 

Input "Y0".
8)	 Konfirmasi dengan menekan Enter  atau [OK].

9)	 Ladder yang diinput ditampilkan              .  
10)	Tekan pada tombol tool   . 

Input "Y0".
11)	Konfirmasi dengan menekan Enter  atau [OK].

batalkan dengan ESC  atau [Exit].

3)	 Ladder yang diinput ditampilkan
X2

.
4)	 Tekan pada tombol tool . 

Input "X0".
5)	 Konfirmasi dengan menekan Enter  atau [OK].

2)	 Konfirmasi dengan menekan Enter  atau [OK].

1)	 Klik pada tombol tool . 
Input "X2".

2) Klik1) Input "X2"

5) Klik4) Input "X0"

3) Elemen ladder ditampilkan

8) Klik7) Input “Y0”

6) Elemen ladder ditampilkan

11) Klik10) Input “Y0”

9) Elemen ladder ditampilkan

X0
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12)	  Ladder yang diinput ditampilkan
Y0

.
13)	  Arahkan kursor pada permulaan garis 	     	

  selanjutnya.
14)	  �Tekan pada tombol tool  . 

Input "X3".
15)	  Konfirmasi dengan menekan Enter  atau         	

  [OK].

16)	  Ladder yang diinput ditampilkan
X3

.
17)	  Tekan pada tombol tool  . 

  Input "Y1".
18)	  Konfirmasi dengan menekan Enter  atau   	

  [OK].

19)	  �Ladder yang diinput ditampilkan.

13) Arahkan kursor

12)  Elemen ladder ditampilkan

15) Klik14) Input "X3"

18) Klik17) Input "Y1"

16) Elemen ladder ditampilkan

19) Elemen ladder ditampilkan

F4  (Convert)

20) Bayangan abu-abu menghilang

20) Operasi Perubahan Rangkaian (Penting).
	 Jalankan operasi F4 (Conversion) untuk 

mengkonfirmasi diagram rangkaian yang 
belum ditetapkan (Bagian dengan warna abu-
abu). 

 
Tekan F4 (Convert) atau pilih  dari 
toolbar atau pilih[Convert] → [Convert] dari 
menu.

Tampilan warna abu-abu menghilang dan 
program terkompilasi. Bila terjadi kesalahan 
kursor akan bergerak ke bagian yang salah. 
Koreksi kembali program.
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Lampiran 1.4 Menuliskan Program ke dalam 
PLC
Menulis program sequence yang telah dibuat pada FX PLC.

Lampiran 1.4.1 Koneksi PC ke  PLC

Koneksikan PLC FX3G (Koneksi dengan kabel USB) 

[Persiapan pada bagian PC] 

Untuk mengkoneksikan PC dan PLC FX3G dengan kabel USB, perlu menginstal USB drive software 
pada PC. 
Untuk menginstal drive software, jalankan sesuai proses [GX Developer Operation Manual (Start up 
edition)].

Port (USB) 
built in PLC

Kabel USB

USB

GX Developer

[Diagram Koneksi]
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Lampiran 1.4.2 Menyetting tujuan koneksi pada GX Developer 

Menjalankan setting untuk mentransmisikan PLC dengan GX Developer. 

1)	 Pilih  [Online] → [Transfer Setup].
2)	 Double-klik ikon .

3)	 Jalankan setting pada port pentransmisi pada 
bagian PC Ketika mengkoneksikan internal 
USB port pada PLC FX3G, pilih [USB]. 

4)	 Klik [OK] setelah setting lengkap.

5)	 Klik [Connection test],untuk cek komunikasi 
dengan PLC.

6)	 Klik [OK] setelah memastikan, tetapkan isi 
setting. 

1) Setup transfer ditampilkan

2) Dobel-Klik

3) (a)

3) (b)

3) (c)

4) Klik

5) Klik

6) Klik



113

Lampiran 1.4.3 Menulis Program 

1)	 Setting switch [RUN/STOP] pada PLC 
menjadi [STOP]. 

3)	 Klik [Param + Prog].
4)	 Klik [Execute].

2)	 Pilih   dari toolbar atau pilih 
[Online] → [Write to PLC] dari menu.

5)	 Setelah selesai klik [OK]. 

2) Klik

4) Klik

3) Pilih data yang 
    ingin ditulis

5) Klik

Ditampilkan dialog box yang menampilkan proses 
writing. 

1) Set untuk 
    "STOP"
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Lampiran 1.4.4 Operasi Monitor pada Program

1)	 Setting switch [RUN/STOP] pada PLC 
menjadi [RUN]. 

1)	 Ketika kondisi [Switch X000 dalam posisi "OFF"], ["ON" kan Switch X002], dan pastikan [Output 
Y000 dalam posisi "ON"]. 

2)	 Walaupun [meng-OFF-kan Switch X002], pastikan [Output Y000 sedang dalam posisi "ON"]. 
3)	 Ketika [meng-ON-kan Switch X000], pastikan [Output Y000 dalam posisi "OFF"]. 
4)	 Sambungkan ["ON/OFF" pada Switch X003], pastikan [Output Y001 dalam posisi  "ON/OFF"]. 

 2) Klik

2)	 Pilih   pada toolbar, atau dari Menu pilih 
[Online] → [Monitor] → [Monitor mode].

1) Set untuk 
    "RUN"

cek operasi melalu mode monitor
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(1) Tampilan Dialog Status Monitor 

4)3)2)1)

(2) Interpretasi dari tampilan monitor ladder

Referensi

1)	 Scan Time 
	 Menampilkan scan time maksimal pada 

program PLC. 
2)	 Kondisi PLC  
	 Menampilkan kondisi PLC. 
3)	 Kondisi monitor execution  
	 Monitor yang sedang berjalan akan 

berkedip. 
4)	 Tampilan isi memori  
	 Menunjukkan memori PLC. 

1)   Instruksi contact
Input contact

Tipe X0: OFF X0: ON

N.O. contact
X000

Contact terbuka

X000

Contact tertutup

N.C. contact
X000

Contact tertutup

X000

Contact terbuka

2)	 Instruksi keluar
Status proses

Tipe
Non-eksekusi/
Tidak berjalan Eksekusi/Berjalan

Instruksi OUT Y000 Y000

Instruksi SET, dll. SET M0 SET M0

Pada instruksi RST, device yang ter- reset dalam kondisi ON/OFF ditampilkan pada monitor. 

Status device
Tipe

Saat device yang 
direset OFF

Saat device yang 
direset ON

instruksi RST 
RST M0 RST M0
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Lampiran 1.5 Editing pada Rangkaian 
Lampiran 1.5.1 Koreksi pada Diagram Rangkaian

•	 Pada saat mengoreksi rangkaian pastikan dalam keadaan "Writing Mode".  
Pilih dari Toolbar.	                      Pilih dari Menu ([Edit]→[Write mode]). 
 
 
 
 
 
 
 
 
 
 
 
 
 

•	 Huruf yang digunakan untuk menginput adalah alphabet (half width character). Tidak bisa 
menggunakan full width character.  

•	 Mengubah "Overwrite" dan "Insert".

• Untuk mengoreksi rangkaian yang sudah ada, jalankan "Overwrite" mode. 
• Apabila menyeting dengan "Insert" mode, maka akan di-insert sebagai tambahan rangkaian yang 

  
berbeda.

Poin

Ganti antara
"Ovrwrte" dengan "Insert"
dengan menekan  Insert  
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1) Mengubah OUT coils dan contact

[Program yang akan dikoreksi]

3)	 Konfirmasi dengan menekan Enter  atau [OK].
4)	 Akan ditampilankan hasil koreksi, dan blok 

rangkaian tersebut ditampilkan dengan warna 
abu-abu. 

1)	 Dobel klik pada bagian yang akan dikoreksi. 

5)	 Konfirmasi dengan menekan F4  (Convert).

X002

Y000

X000

X003
Y001

Y002

Y000

Ganti menjadi

2)	 Ganti "Y001" menjadi "Y002".

1) Dobel-klik

2) Ganti "Y002"   3) Tekan  Enter  

5) F4 (Convert)

4) hasil yang telah dikoreksi ditampilkan
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2) Menambahkan garis

[Program yang akan dikoreksi]

3)	 Border akan ditambahkan pada posisi yang 
di-drag. 

4)	 Arahkan kursor pada posisi OUT Coil 
ditambahkan, dan klik pada toolbar.

1)	 Klik  ( F10 ) pada toolbar. 

X002

Y000

X000

X003
Y001

Y000

Y003

Tambahkan garis
vertikal/horizontal 
untuk membuat 
OUT coil

2)	 Arahkan kursor pada bagian kanan atas dari 	
vertical line yang akan ditambahkan, drag ke 
posisi akhir dan lepaskan. 

5)	 Input "Y3".
6)	 Konfirmasi menggunakan Enter  atau [OK].

1) Klik

2) Drag

Tempatkan kursor pada bagian kanan atas 
dari posisi awal garis vertikal yang akan ditambahkan

5) Ubah "Y3"   6) Tekan tombol Enter

Garis telah ditambahkan

4) Posisi kursor
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8)	 Konfirmasi perubahan isi dengan menekan 
tombol  F4  (Convert).  
 
• Klik  pada toolbar sekali lagi untuk                        

        menyelesaikan operasi.

7)	 Blok rangkaian akan ditampilkan dengan 
warna abu-abu ketika penambahan selesai 
dilakukan. 

7) Ladder yang 
    ditambahkan telah lengkap

8) F4 (Convert)
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3) Menghapus garis

[Program dengan garis yang akan dihapus

4)	 Hapus OUT coil mengguanakan Delete .
5)	 Blok rangkaian yang sudah dihapus 

ditampilkan dengan warna abu-abu. 

1)	 Klik  Alt  + F9  pada toolbar.

X002

Y000

X000

X003
Y001

Hapus 
ladder ini

Y000

Y003

2)	 Arahkan kursor pada bagian kanan atas dari 
line vertical yang akan dihapus, drag ke posisi 
akhir dan lepaskan. 

3)	 Garis yang akan dihapus.

1) Klik

2) Drag

Tempatkan kursor pada sebelah kanan
atas dari garis vertikal yang akan dihapus

3) Garis yang akan dihapus

4) Hapus menggunakan  Delete  
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6)	 Konfirmasi penggantian dengan F4  
(Convert).

• Klik  pada toolbar lagi untuk 
  menyelesaikan operasi.

6) F4 (Convert)
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Lampiran 1.5.2 Memasukkan dan menghapus garis

1) Menambahkan baris

[Program dimana baris akan dimasukkan]

3)	 Baris telah dimasukkan.

X002

Y000

X000

X003
Y001

Tambahkan baris iniX001

Y000

Y002

2)	 Klik kanan pada mouse dibagian manapun, 
pilih  [Insert Row].

Untuk line, arahkan kursor pada bagian atas baris 
yang akan dimasukkan. 

1)	 Letakan kursor pada line bagian bawah yang 
akan dimasukkan. 

4)	 Tambahkan ladder pada baris yang telah 
dimasukkan.

5)	 Konfirmasi menggunakan Convert  (F4).

   1)  Arahkan kursor di bawah 

        salah satu baris yang akan dimasukkan

Pilih "Insert Row"

2) 
Klik kanan
pada mouse

3) Baris baru telah dimasukkan

4) Tambahkan ladder
X001

Y002
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2) Menghapus baris

[Program dimana baris akan dihapus]

3)	 Baris telah dihapus.            

1)	 Arahkan pada baris yang akan dihapus.

X002

Y000

X000

X003
Y001

Hapus baris ini

X001

Y000

Y002

2)	 Klik kanan pada mouse dibagian manapun.
pilih [Delete Row].

Pada saat menghapus baris, walau warna 
abu-abu tidak ditampilkan, tekan Convert  
(F4).untuk mengkonfirmasi.

Poin

1) Arahkan kursor pada
    baris yang akan dihapus

Pilih "Delete Row"

2) Klik kanan
    pada mouse

3) Baris telah dihapus
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Lampiran 1.5.3 Cut dan Copy (Paste) pada pada ladder

1) Cut

[Program yang akan diedit]

1)	 Arahkan kursor pada bagian awal rangkaian 
yang akan di-cut.

X002

Y002

X000

X004
Y004

X007

Y002

Y007
Cut baris ini

2)	 Drag keposisi akhir dan lepaskan.
3)	 Pilih tanda   pada toolbar, atau dari Menu.
4)	 Pilih  [Edit] → [Cut] ( Ctrl  + X ) dari menu, 

dan lakukan cut.
5)	 Area yang dipilih telah di-cut. 

6)	 Range yang dipilih telah terpotong. Apabila 
salah satu bagian rangkaian telah terpotong, 
karena warna abu-abu akan tetap tersisa, 
tetapkan dengan menekan tombol F4  
(Convert).

Area cut dan copy 1) Arahkan kursor
    pada permulaan area
    yang akan di-cut

2) Drag mouse sampai posisi yang
    diinginkan lalu lepaskan.

3) Cut

4) Area yang telah 
    diseleksi telah di-cut
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1)	 Arahkan kursor pada awal rangkaian yang 
akan di-copy. 

2)	 Drag ke posisi terakhir dan lepaskan. 
3)	 Pilih  pada toolbar, atau dari menu pilih 

[Edit] → [Copy] ( Ctrl  + C ).

5)	 Pilih  pada toolbar, atau dari menu 
pilih[Edit] → [Paste] ( Ctrl  + V ). 
Apabila salah satu bagian rangkaian telah di-
paste, karena warna abu-abu akan tersisa, 
konfirmasi dengan menekan tombol F4 (Convert).

4)	 Arahkan kursor pada posisi yang akan 
dipaste.

Ganti Insert  "Overwrite" mode: posisi 
kursor akan   di-paste-kan pada overwrite. 
"Insert"mode: di-insert pada bagian atas 
 posisi kursor. 

Poin

2) Copy(Pasting)

1) Arahkan kursor pada permulaan
    area yang akan di-copy

3) Eksekusi
    copy

2) Drag mopuse sampai posisi yang                  
diinginkan kemudian lepaskan.

4) Arahkan kursor pada     
posisi paste

5) Copy/paste selesai

Y000

X004

X000

X002
Y000

X002
Y000

Y000

X000

Y004

Copy baris ini

Paste baris
di sini
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Lampiran 1.6 Menyimpan program
Lampiran 1.6.1 Save as dan save

Apabila ada rangkaian yang tidak berubah pada program, setelah pengoperasian tekan Convert  (F4).

Poin

1)	 Pilih  dari toolbar atau Pilih [Project] → 
[Save] ( Ctrl  + S ) dari menu.

6)	 Klik Yes  pada dialog konfirmasi untuk 
menyelesaikan.

	
Pada saat terjadi kekurangan kapasitas pada 
penyimpanan di floppy disk, untuk sementara simpan 
di hard disk, setelah itu pindahkan project ke floppy 
disk yang lain.

2)	 Tentukan dengan spesifik tujuan 
penyimpanan project.

3)	 Tentukan dengan spesifik nama project.
4)	 Tentukan dengan spesifik judul yang 

mendeskripsikan project (opsional).
5)	 Klik Save .

Referensi

1) Klik

3) Beri nama project yang spesifik

2) Beri tujuan penyimpanan
     yang spesifik untuk project

5) Klik

4) Spesifik file (opsional)

6) Klik

(Apabila menyimpan project yang benar-benar baru)

(Ketika disimpan akan menimpa file sebelumnya)

Project saving telah selesai

•	 Untuk nama project tanda baca dibawah ini tidak dapat dipakai /, \, >, <, *, ?, ", ", |, :, ; ( ;, \ hanya bisa untuk setting 
penentuan drive)  Selain itu jangan gunakan . (period) pada akhir project name. 

•	 Pada saat menyeting project name sebanyak lebih dari 8 karakter huruf dengan GX Developer (setelah SW6D5- 
GPPW), apabila me-reading file tersebut dengan versi GX Developer (sebelum SW2D5-GPPW), maka 8 karakter 
huruf keatas tidak bisa ditampilkan. 

•	 Jumlah karakter huruf untuk project path + project name adalah kurang dari 150 huruf untuk half width character ( 75 
huruf untuk full width character). 

•	 Jumlah karakter huruf untuk headline kalimat adalah kurang dari 32 huruf untuk half width character (16 huruf untuk full 
width character). 

•	 Pada saat tidak ada space pada project path dan project name, file GPPW.gpj, ***.gps pada explore walaupun didobel  
klik, GX Developer tidak akan start up dengan normal. 

•	 Apabila ada space pada project path dan project name, setelah start up GX Developer [Project] -> [Open project], dan 
buka project melalui Menu. 
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Apabila ada rangkaian yang tidak berubah pada program, setelah pengoperasian, tekan Convert  (F4).

Poin

Lampiran 1.6.2 Menyimpan project sebagai satu yang baru

1)	 Pilih [Project] → [Save as] dari menu.

2)	 Tentukan dengan spesifik tujuan 
penyimpanan untuk prject.

3)	 Tentukan dengan spesifik nama project.
4)	 Tentukan dengan spesifik judul yang 

mendeskripsikan project (opsional).
5)	 Klik Save .

6)	 Klik Yes  dalam dialog konfirmasi.

Untuk penanganan drive/path name dan project 
name silahkan merujuk pada halaman sebelumnya. 

Pada saat terjadi kekurangan kapasitas pada 
penyimpanan di floppy disk, untuk sementara simpan 
di hard disk, setelah itu pindahkan project ke floppy 
disk yang lain.

1) Klik

3) Beri nama project yang spesifik

2) Beri tujuan penyimpanan 
    yang spesifik untuk project

5) Klik

4) Spesifik judul (opsional)

6) Klik
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Lampiran 1.6.3 Membaca project

1)	 Pilih  dari toolbar atau Pilih [Project] → 
[Open project] ( Ctrl  + O ) dari menu.

Apabila ada project lain yang terbuka pada saat reading operation, project tersebut dapat ditutup. 
Akan ditampilkan warning message apabila ada rangkaian yang tidak berubah pada project dan 
belum tersimpan.

Referensi

2)	 Pilih tujuan penyimpanan project.
3)	 Pilih project untuk dibaca.
4)	 Klik Open  dan baca project.

1) Klik

3) Pilih project yang akan dibaca

4) Klik

2) Pilih tujuan 
penyimpanan project.
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Lampiran 1.7 Operasi yang Diperlukan pada Debug Program 
Tentang koneksi dengan PLC dan writing program silahkan merujuk pada  "lampiran 
1.4 Writing Program ke PLC". 

Lampiran 1.7.1 Monitor Ladder
Memonitor kondisi konduksi pada N.O. contact dan kondisi drive coil melalui tampilan rangkaian. 

2)	 Pada window monitor rangkaian, ditampilkan 
kondisi ON/OFF rangkaian dan current 
value dari word device (Timer, Counter, Data 
register).

3)	 Klik kanan window, Pilih [Stop monitor] tuntuk 
keluar dari monitor ladder.

4)	 Untuk menjalankan koreksi program dan 
writing program pilih   dari toolbar atau 
Pilih [Edit] → [Write mode] dari menu.

1)	 Pilih  dari toolbar atau Pilih [Online] → 
[Monitor] → [Monitor mode] dari menu.
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(1) Tampilan status dialog monitor

4)3)2)1)

(2) Interpretation tampilan monitor ladder

Referensi

1)	 Scan Time  
	 Menampilkan scan time maksimal pada 

program sequence. 
2)	 Kondisi PLC 
	 Menampilkan kondisi PLC. 
3)	 Kondisi monitor execution 
	 Monitor yang sedang berjalan akan 

berkedip. 
4)	 Tampilan isi memori
      Menunjukkan memori PLC.

1)	 Instruksi Contact
Input contact

Tipe X0: OFF X0: ON

N.O. contact
X000

Contact terbuka

X000

Contact tertutup

N.C. contact
X000

Contact tertutup

X000

Contact terbuka

2)	 Instruksi Out 
Driving status

Tipe
Non-eksekusi/

Tidak perlu dijalankan Eksekusi/dijalankan

OUT Instruksi Y000 Y000

SET Instruksi , etc.
SET M0 SET M0

Status ON/OFF yang akan direset akan ditampilkan oleh monitor monitor menggunakan Instruksi 
RST. 

Device status
Tipe

Saat device yang 
direset OFF

Saat device yang 
direset ON

RST Instruksi 
RST M0 RST M0
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Lampiran 1.7.2 Monitor registrasi device

1) Meregistrasi devices pilihan
Meregistrasi device apapun pada monitor window, dan memonitor bagian-bagian pentingnya saja.

4)	 Device telah teregristasi dalam jendela 
monitor.

5)	 Klik [Register], dan value akan menunjuukan 
device action dan status ON/OFF contact dan 
coils akan ditampilkan.

6)	 Device teregistrasi.
7)	 Klik [start monitor].

1)	 Kondisikan pada monitor rangkaian (merujuk 
lampiran 1.7.1).

2)	 Pilih [Online] → [Monitor] → [Entry data 
monitor] dari menu atau klik kanan pada 
jendela ladder Pilih [Entry data monitor]. Klik 
[Register devices] dalam "Entry data monitor"  
Input nomor device untuk diregistrasi dalam 
jendela registrasi device. 

3) Klik

Pilih "32 bit integer" 
bila anda ingin 
membuat device
menjadi 32 bit. 

4) Input device

5) Klik

7) Klik

3)	 Klik [Register Device].
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1)	 Set menjadi mode monitor. (Merujuk 
Lampiran 1.7.1).  

2)	 Pilih [Online] → [Monitor] → [Entry data 
monitor] dari menu atau Klik kanan the ladder 
monitor window dan Pilih [Entry data monitor]. 
(See the previous page). 

3)	 Pilih [Window] → [Tile horizontally] dari menut 
lalu akan ditampilkan berurutan [Window 
circuit] dan [Window Device Registration 
Monitor]. (Kondisikan [Window Device 
Registration Monitor] dalam kondisi monitor 
stop). 

4)	 "Window circuit" dan "Window device 
registration monitor" ditampilkan atas dan 
bawah. 

2) Meregistrasi devices yang ditampilkan dalam monitor 
ladder 
Tentukan dengan spesifik area ladder dalam jendela ladder monitor window registrasi semua device 
dalam area.

5) Klik permulaan ladder.

6) Klik titik akhir sambil menekan
    [Shift] untuk memilih area.

7) Drag

8)	 Device teregistrasi di window monitor. 
9)	 Jika klik [Start monitor], maka akan 

ditampilkan kondisi ON/OFF dari coil dan 
contact, dan juga isi dari value pengoperasian 
device.

9) Klik

5)	 Klik titik awal rangkaian. 
6)	 Klik titik akhir sambil menekan tombol [Shift] 

dan pilih range. 
7)	 Drag range yang dipilih pada "window device 

registration monitor" dengan mouse sambil 
menekan tombol [Ctrl]. 
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Lampiran 1.7.3 Device batch monitor
Tentukan dengan spesifik nomor device awal dan memonitoring device yang berturut-turut. 

1)	 Kondisikan pada monitor rangkaian (merujuk 
pada Lampiran 1.7.1). 

2)	 Pilih [Online] → [Monitor] → [Device batch] 
dari menu atau Klik kanan ladder window dan 
Pilih [Device batch].

3) Input device

4)	 Ditampilkan kondisi ON/OFF dari coil dan 
contact, dan isi dari value pengoperasian 
device. 

3)	 Input nomor awal dari device yang dimonitor 
pada window [Device batch monitor] lalu 
tekan  Enter  lalu klik [Start monitor].
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Lampiran 1.7.4 Test Device 

1) Forcing ON/OFF 
Meng-ON/OFF-kan secara paksa bit device (M, Y, T, C dll) pada PLC .(Tidak bisa untuk forcing ON/
OFF X). 
Pada saat PLC dalam kondisi RUN, pengoperasian ON/OFF hanya 1 periode kalkulasi 
saja, diprioritaskan pengoperasian oleh sequence program. Untuk setiap pelaksanaan output 
confirmation, buat PLC dalam kondisi STOP. 

1)	 Kondisikan pada monitor 	rangkaian (merujuk 
pada lampiran 1.7.1). 

2)	 Pilih [Online] → [Debug] → [Device test] dari 
menu atau Klik kanan  ladder window dan 
Pilih [Device test].

Forced ON/OFF (Jendela Monitor Ladder)
Sambil menekan [Shift] pada [Ladder Monitor Window], dobel klik pada bit device apapun (Contact, 
Coil), maka device yang dipilih akan dapat di-forcing ON/OFF. 

Referensi

3) Input device

4) Klik

3)	 Input nomor device yang di-forcing ON/OFF.  

4)	 • [FORCE ON]: Memaksa device ON. 
• [FORCE OFF]: Memaksa device OFF. 
• �[Toggle force]: Memaksa device ON/FF 

setiap kali ditekan.
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2) Mengganti Current Value pada Word device  
Merubah current value pada word device PLC's (T, C, D dll) ke value yang telah ditentukan. 

1)	 Kondisikan pada monitor rangkaian (Merujuk 
pada bagian 1.7.1.). 

2)	 Pilih [Online] → [Debug] → [Device test] dari 
menu atau klik kanan jendela ladder dan pilih 
[Device test].

3) Input device

5) Klik   4) Value baru

3)	 Input nomor device yang diubah. 
4)	 Input value yang diubah. 
5)	 Klik [Set]. 
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Lampiran 1.7.5 Menulis program pada PLC saat sedang RUN
Ketika PLC sedang RUN, hanya bagian rangkaian yang telah dikoreksi yang dapat dituliskan pada PLC. Agar 
keseluruhan program tidak tertransfer lakukan writing program jangka pendek.

1)	 Menjelaskan contact pada bagian kiri 
rangkaian dengan contoh yang ditambahkan. 
Tampilkan diagram rangkaian dan kondisikan 
menjadi writing mode (  ).

Apabila tidak ada kesamaan antara program dalam PLC sebelum dikoreksi dengan program dalam GX 
Developer maka writing tidak dapat dilaksanakan. Silahkan konfirmasi dahulu mengenai kesamaan 
program dan kejelasannya, atau silahkan tra nnsfer kolektif dengan [Write to PLC]. 

Perhatian

2)	 Tambahkan contact. Blok rangkaian 
ditampilkan dengan warna abu-abu.

3)	 Tekan [Shift] and [F4] bersamaan, atau pilih 
[Convert] → [Convert (Write during RUN)] dari 
menu.

5)	 Klik [OK] pada tampilan message "Writing 
Process during RUN Complete".

2) Tambahkan contact

4) Klik

5) Klik

Menulis saat RUN	  [Shift]+[F4]

4)	 Klik [Yes] untuk mengkonfirmasi peringatan.
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Lampiran 1.8 Comment Untuk Input
Lampiran 1.8.1 Tipe-tipe comment
Berikut adalah 3 tipe comment yang bisa diinput. 

Tipe Tujuan Jumlah 
Karakter Keterangan 

1) Comment 

Comment yang menunjukkan 
peranan dan kegunaan 
tiap device. 16

Untuk writting pada PLC, "Comment 
setting"diperlukan capacity pada 
parameter. Kemudian juga diperlukan 
"Comment range setting" pada writting.

2) Statement
Comment yang menunjukkan 
peranan dan kegunaan 
rangkaian blok.

32
Comment hanya untuk bagian software 
pada PC (Peripheral). (Tidak masuk 
dalam PLC).

3) Note
Comment yang menunjukkan 
peranan dan kegunaan 
instruksi output.

16
Comment hanya untuk bagian software 
pada PC (Peripheral). (Tidak masuk 
dalam PLC).

[Contoh comment ]

Cara menampilkan Comment
•	 Dari Menu pilih [Display] → [Display comment] dan comment akan ditampilkan.

•	 Untuk menghentikan tampilan comment, lakukan kembali pengoperasian di atas.

Poin

T5 N.O. contact berada pada step 10, di-
mana T5 N.C. contact berada pada step 8.

3) Note

2) Statement

1) Comment

X000

Y000

Y000

T5

T7
Mulai

Lampu hijau

Waktu berhenti
conveyor

Rangkaian START 

Setting waktu buzzer

Lampu hijau

Timer 2 detik

0

4

8

<tombol mulai nyala lampu>

<Buzzer berdering >

(Y000   )
Y000
A/S
A/S

1

T5
B/D
B/D

10
8

4
Lampu
hijau

K20

(Y001   )
Buzzer

T5
Timer 
2-detik
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Lampiran 1.8.2 Operasi Pembuatan Device Comment 

1) Input Method dari daftar 

1)	 Double Klik [Device comment] → 
[COMMENT] dalam project list.

1) Klik

2)	 Input nomor awal dari device yang akan 
membuat comment pada [Device name] lalu 
klik [Display]. 

3)	 Input Comment pada kolom [Comment] Untuk 
menginput comment pada device yang lain 
inputkan lagi nomor device dengan cara 2.

2) Input nomor device

3) Input comment

1)	 Klik  dari toolbar dan klik kanan the ladder 
element.  

2)	 Input comment dalam jendela "Enter symbol" 
dan klik [OK]. 
 
• �Klik  pada toolbar sekali lagi utnuk 

menyelesaikan operasi.

2) Bagaimana input device dengan comment dalam ladder

1) Dobel klik

2) Input comment
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Setting untuk Writing Device Comment pada PLC 
Untuk writing device comment pada PLC, diperlukan "Parameter Setting" dan "Range 
Comment Setting".

1)	 Parameter setting
•	 Pilih [Parameter] → [PLC parameter] dalam project list.

•	 Setting "Jumlah blok" pada settingan [Kapasitas comment]. Sekitar 1 blok setara dengan 50 poin 
comment, dan memakan kapasitas program 500 step bagian. 

Setting kapasitas comment

Kapasitas program berkurang seiring 
dengan bertambahnya blok comment 
yang ditambahkan.

2) Setting jangkauan comment
•	 Pilih [Device comment] → [Comment], dan layar input comment akan ditampilkan. 

•	 Pilih [Edit] → [Setup comment range] dari menu.

•	Pada dialog setting range comment, setting tipe dan range pada device yang di-tulis 
pada PLC.

Setting jangkauan
comment

Continues during command write

[Common Program] tandai [Continue while writing 
instruction] pada kolom [Input Comment]. 

Pada pelaksanaan setting ini, akan berlanjut 
pada pengoperasian input rangkaian pada saat 
pembuatan rangkaian, dan akan ditampilkan pada 
window [Input Comment] bagian  2) di atas. 

Poin

Referensi



140

Lampiran 1.8.3 Operasi untuk membuat statement

1)	 Klik  dari toolbar, dobel klik bagian apapun 
pada blok rangkaian yang akan diinput 
statement. 

2)	 Input statement pada window "Enter line 
statements" lalu klik [OK]. 
• �Klik  sekali lagi untuk menyelesaikan 

operasi.

Lampiran 1.8.4 Operasi untuk membuat notes
1)	 Klik  dari toolbar, dobel klik pada Output 

instruction symbol yang akan  diinput note. 
2)	 Input note dalam jendela "Enter Note" 

kemudian klik [OK]. 
 
• �Klik  sekali lagi untuk menyelesaikan 

operasi.

1) Dobel klik

2) Input statement

2) Input note

1) Dobel klik
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Lampiran 1.9 Operasi Pembuatan Daftar Program
Dengan GX Developer dapat dibuat program dengan menggunakan list method. st.

Lampiran 1.9.1 Tampilan List Layar Edit 

1)	 Pembuatan baru project. (Merujuk pada 
lampiran 1.2.2). Atau menampilkan rangkaian 
project yang telah ada. 

2)	 Pilih  dari toolbar atau Pilih [View] → 
[Instruction  list] dari menu.

Lampiran 1.9.2 Cara Input Instruksi 

1)	 Input dengan language instruction sesuai 
urutan dari step 0. Tampilan nomor step akan 
bertambah secara otomatis setiap input. 
(Untuk cara inputnya silahkan merujuk pada 
halaman selanjutnya). 

1) Daftar edit layar ditampilkan.

3) Layar untuk edit
daftar ditampilkan

Layar Inisial            Daftar setelah input 

3)	 Ditampilkan list layar edit. Apabila akan 
mengembalikan ke tampilan rangkaian, 
klik lagi   atau dari Menu pilih  [View] → 
[Ladder].
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[Contoh dari instruksi dasar]
LD 
OUT
LDI
AND
OUT
LD
OUT
OUT

[Conoh untuk aplikasi intruksi]
MOV
CMP

X0	 Enter

Y0	 Enter

X0	 Enter

Y0	 Enter

M0	 Enter

M0	 Enter

T0    K10	 Enter

C0    K5	 Enter

K1    D0  	 Enter

K20  D3  M10	 Enter

●● Cara Input Instruksi Dasar dan Instruksi Aplikasi 
Input Language instruction dengan nomor device dan operand dengan memisahkannya 
menggunakan [Space].

Koneksi dan instruksi OUT 

Tombol pengoperasian pada saat Input / Edit
 • Mode "Ovrwrte"/"Insert" diganti dengan menggunakan Insert .

 • Instruksi dapat dihapus menggunakan Delete .

Operasi [Insert line] dan [Delete line] dapat dilakukan dengan klik kanan mouse.

Referensi

Instruksi coil untuk timer dan counter
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Lampiran 1.9.3 Pemastian Isi Input List 
Program yang telah diinput list ditampilkan dalam rangkaian dan pastikan tidak ada 
kesalahan apapun.

1)	 Pilih  pada toolbar, atau pilih  
 [View] → [Ladder] dari menu.

2)	 Pastikan rangkaian yang telah diinput list 
sedang ditampilkan. 

3)	 Pilih [Tools] → [Check program] to execute 
tdengan menjalankan pengecekan, maka ada 
tidaknya kesalahan dan adanya kesalahan 
step dapat dipastikan. 
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MEMO
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Lampiran 2
Contoh Pengenalan Daftar Program
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Contoh pengenalan 1
Daftar Program: Contoh 1

Daftar Program: Contoh 2

Daftar Program

Daftar ProgramDaftar Program

Step Perintah
0 LD X001
1 OR Y000
2 ANI X003
3 OUT Y000
4 OUT Y003
5 END

Step Perintah
0 LD X001
1 SET Y000
2 SET Y003
3 LD X003
4 RST Y000
5 RST Y003
6 END

Step Perintah
0 LD X000
1 AND X001
2 OUT Y001
3 LD X003
4 OR Y003
5 ANI X004
6 OUT Y003
7 LD Y003
8 OUT C0 K5
11 LD C0
12 OUT Y000
13 LD X002
14 RST C0
16 END

Contoh pengenalan 2

Contoh pengenalan 3

Step Perintah
0 LD X001
1 OR Y003
2 ANI C0
3 OUT Y003
4 LD X004
5 OUT C0 K4
8 LD C0
9 OUT Y001
10 OUT T0 K10
13 AND T0
14 OUT Y002
15 OUT T1 K20
18 LD T1
19 RST C0
21 END

Contoh pengenalan 4

Step Perintah
0 LD X001
1 OR Y000
2 ANI X003
3 OUT Y000
4 LD Y000
5 AND X000
6 OUT Y002
7 AND Y002
8 MPS
9 AND X005
10 ANI Y003
11 OUT Y001
12 MPP
13 AND X006
14 ANI Y001
15 OUT Y003
16 END

Lampiran 2.1 Daftar Programs 
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Daftar Program
Contoh pengenalan 5

Step Perintah
0 LD X001
1 OR Y000
2 ANI T4
3 OUT Y000
4 OUT T0 K20
7 LD T0
8 OUT Y001
9 OUT T1 K20
12 LD T1
13 OUT Y002
14 OUT T2 K20
17 LD T2
18 OUT Y003
19 OUT T3 K20
22 LD T3
23 OUT Y004
24 OUT T4 K20
27 END
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Apabila Anda menggunakan Handy Programing Panel 
(HPP) ...
Apabila Anda menggunakan HPP, Anda dapat mengedit program list method dengan mudah. 
Dengan HPP, pembuatan program dan debug peralatan menjadi lebih mudah dan praktis, 
bahkan untuk perubahan konstan seperti perubahan program yang simpel di lapangan yang 
PC tidak dapat di-setting tetap dan juga pada timer/counter. 

        

Untuk konfirmasi isi dari kesalahan pun …
Dengan menggunakan fungsi program check dan fungsi monitor HPP, konfirmasi isi dari 
kesalahan dapat diproses dengan mudah. 

Untuk penyimpanan program dan sebagai alat transfer 
PLC …
HPP tipe FX-30P dapat menyimpan program sequence maksimal 15 buah (untuk program yang 
melampaui 32000 step maksimal 7 buah). Perubahan program pada peralatan yang terpisah 
dapat dilakukan tanpa PC. Selain itu pada PLC yang jumlahnya banyak, dalam pengoperasian 
pada program writing yang sama pun tidak diperlukan PC.

Bisa juga untuk peralatan yang digunakan diluar 
negeri ...
Karena HPP tipe FX-30P dapat merespon perubahan tampilan bahasa ke dalam bahasa 
Jepang, Inggris, dan China, maka dapat digunakan sebagai programing tool pada peralatan 
yang digunakan diluar negeri. 

Lampiran 3
Manfaat Handy Programing Panel          
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PLC

Handy programming panel (HPP) 
FX-30P main unit

Kabel program 
FX-20P-CAB0
 (1.5 m)

Port pemrograman

Jika Anda menggunakan HPP tipe FX-30, Anda dapat mengedit program list method dengan mudah. 
Dengan HPP pembuatan program dan debug peralatan menjadi lebih mudah dan praktis, bahkan 
untuk perubahan konstan seperti perubahan program yang simpel di lapangan yang PC tidak dapat 
di-setting tetap dan juga pada timer/counter. 

1) Fungsi praktis untuk start up peralatan
•	Edit program berdasarkan instruction list.
•	Monitor device dan Forcing ON/OFF. 

2) Fungsi praktis pada saat terjadi kesalahan 
•	Fungsi program check. 
•	Fungsi PLC diagnosis.

3) Fungsi praktis untuk proteksi
•	Fungsi ubah waktu timer dan setting value counter.
•	Fungsi transfer sequence program yang telah di-update (untuk program dibawah 32k bisa 
menyimpan maksimal 15 buah dalam HPP).

4) Fungsi praktis untuk peralatan yang digunakan di luar negeri
•	Message operation bisa diganti ke bahasa Inggris, China, dan Jepang.

[Contoh penyambungan] [Dimensi  FX-30P]

87mm

17
0m

m

Berat : 0.3kg

Lampiran 3.1 Manfaat Handy Programing Panel (HPP)
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[FX-30P Daftar Fungsi]
■■ Online mode (Fungsi untuk mengakses langsung pada memori PLC)

Fungsi Deskripsi

Programming

Read Membaca program sequence (dari memori program di dalam PLC ke layar FX-30P).

Write
Menulis program sequence (dengan tombol input FX-30P ke dalam memori 
program di dalam PLC).

Insert
Jalankan instruksi Insert pada program sequence. (Tombol Input FX-30P ke PLC 
program memory) .

Delete
Menghapus instruksi dari program sequence (Tombol Input FX-30P ke memori PLC 
program).

Monitor Membaca keadaan operasi (dari memori di dalam PLC ke layar FX-30P).
Test Menulis device dengan paksa (Tombol Input FX-30P ke memori PLC program).

Lainnya

Offline select Berganti ke mode offline.
PLC diagnosis Mendiagnosa PLC.
Memory cassette transfer Transfers data ke kaset memori.
Parameter Set parameter.
Keyword Set keywords.
Device conversion Menjalankan konversi device.
Latch clear Menjalankan latch clear.
Device batch monitor Menjalankan device batch monitor.
BFM batch monitor Menjalankan buffer memory batch monitor.
Baud rate Merubah baud rate.
PLC memory clear Membersihkan memori dalam PLC.
Remote RUN/STOP Merubah keadaan PLC pada kondisi “RUN” dan “STOP”.
PLC clock setting Set jam pada PLC.
HPP setting Set HPP.

■■ Offline mode (Fungsi mengakses memori RAM di dalam FX-30P)
Fungsi Deskripsi

Programming

Read Membaca program sequence (dari RAM yang ada pada FX-30P ke layar FX-30P).
Write Menulis program sequence (dengan input tombol dari FX-30P ke dalam RAM built in FX-30P).

Insert
Menjalankan instruksi Insert pada program sequence. (dengan input tombol dari FX-30P 
ke dalam RAM built in FX-30P).

Delete
Menghapus instruksi dari program sequence (dengan input tombol dari FX-30P ke 
dalam RAM built in FX-30P).

Lainnya

Online select Berganti ke online mode.
Program check Cek programs.
HPP-FX transfer Transfer data antara RAM built in the FX-30P dan FX PLC.
HPP-PC transfer* Transfer data antara RAM built in the FX-30P dan PC.
Parameter Set parameters.
Device conversion Menjalankan konversi device.
PLC type Mengganti tipe PLC.
HPP memory clear Membersihkan memori di dalam FX-30P.

Program management
Mengatur progam yang tersimpan di dalam RAM dan memori flash (15 blok) yang ada 
dalam FX-30P.

HPP setting Set HPP.

*: Firmware Ver. 1.10 atau versi selanjutnya mendukung transfer data antara HPP dan PC.

■■ HPP setting (Setting fungsi untuk unit utama FX-30P )
Fungsi Deskripsi

Bahasa Pilih bahasa display (Inggris, Jepang dan China).
Volume suara buzzer Mengatur volume suara buzzer.
LCD contrast Mengatur kontras LCD.
Kecerahan Backlight Mengatur kecerahan backlight.
Screen saver Set screen saver.  
Perlindungan HPP Set perlindungan untuk program yang disimpan di dalam FX-30P.
HPP initialization Mengembalikan setting FX-30P menjadi setting pabrik.
HPP F/W update Untuk update firmware yang tersimpan di dalam FX-30P.

[Dimensi  FX-30P]
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Lampiran 4
Pengkabelan Pada Mesin 
Latihan
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L

N

X000

X001

X002

X003

X004

X005

X006

Y004

Y003

Y002

Y001

Y000

0 V

S/S 24 V

COM0
to

COM2

Power supply
100 V AC

Breaker
Micro PLC

FX3G-14MR/ES

Lampu (merah)

Volume
Kecil   Besar

Buzzer

Kontraktor Elektromagnetik

Relay

Katup Solenoid

Select switch

Proximity switch

Limit switch

Toggle switch

Pushbutton switch

Pushbutton switch

Contact
Motor

Mesin Pelatihan Tipe FX-I/O-DEMO2 

 A

A 

Koneksi ke

Koneksi ke

Lampiran 4.1 I/O Diagram kabel untuk mesin latihan 
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Data Revisi Buku Panduan
Tanggal Pembuatan Sub-nomor Konten

Agustus 2014 A Edisi pertama
Mei 2015 B Isi catatan untuk “Hubungi” diperbarui.
Juli 2016 C Menambah dan merevisi deskripsi lainnya.
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